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RESUMEN

Las tecnologias inaldmbricas han tomado un impulso enorme en las Gltimas décadas y el
desarrollo de nuevas y mas eficientes formas de transmitir la informacién se han vuelto cada
vez mas comunes por lo que como un aporte a dicho impulso se realizara un antena del tipo
vivaldi para que funcion en ambientes indoor, tomando en cuenta las especificaciones de la FCC
(Federal Communications Commission) que manifiesta que, para que se considere
comunicaciones de UWB es necesario cumplir con dos definiciones, el ancho de banda debe ser
> 500 MHz y el ancho de banda fraccional > 20% realizado el céalculo pertinente se obtiene
700Mhz con una frecuencia de 3,5 GHz, datos que son fundamentales al momento de iniciar el
disefio tedrico, el cual se basard en los fundamentos de disefio obtenidos en la literatura

existente.

Una vez se obtengan los datos se procederd a optimizar el disefio en un software
especializado (simulador de onda completa), haciendo barridos paramétricos para optimizarlos,
para proceder a la fabricacion de la antena en el sustrato méas indicado y con los pardmetros
obtenidos de la optimizacion, cabe anotar que se deben realizar dos antenas iguales para la
medicion de los patrones de radiacion y demas pardmetros, ya que se pretende utilizar el método
de espacio libre en el que se mide los parametros de la antena con un instrumento especializado

conocido como VNA (Analizador de redes vectoriales)
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ABSTRACT

Wireless technologies have taken a huge impact in recent decades and the development of
new and more efficient ways of transmitting information, has become increasing common, so
as a further contribution to this boost, a vivaldi antenna will be made to what function in indoor,
taking into account the specifications of the FCC (Federal Communications Commission) that
tells us that, in order to be considered UWB communications, it is necessary to comply with two
definitions, the bandwidth must be > 500 MHz and the fractional bandwidth > 20% Performing
the relevant calculation we obtain 700Mhz with a frequency of 3.5 GHz, data that are
fundamental at the time of starting the theoretical design, which will be based on the design
fundamentals obtained in the existing literature.

Once the data is obtained, the design will be optimized in a specialized software (full wave
simulator), making parametric sweeps to optimize them, to proceed with the manufacture of the
antenna in the most indicated substrate and with the parameters obtained from the optimization,
It should be noted that two equal antennas must be made for the measurement of radiation
patterns and others parameters, since it is intended to use the especial equip called VNA

(Vectorial Network Analizer).
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INTRODUCCION

Antecedentes

Los sistema de comunicacion UWB, son sistemas de avance tecnoldgico acelerado con
caracteristicas atractivas y U(nicas, que prometen grandes avances en comunicaciones
inalambricas, redes, radares, imagenes, posicionamiento, ademas de trasmision de datos a alta
velocidad, desde que la FCC dio luz verde para su estudio en el 2002 y se aprobaran los
estandares IEEE 802.15.3a y 802.15.4a, se han desarrollado varios estudios y modelos para su
funcionamiento, entre los cuales estan las antenas que puede utilizarse para mejorar dicha
tecnologia, por ejemplo; LTSA (Lineal Tapered Slot Antenna), CWSA (ConstantWidth Tapered
Slot Antenna) y ETSA (Exponential Tapered Slot Antenna), también llamada Vivaldi.

MUY A

c
Figura 0.1. Diferentes tipos de formas de antenas taped-slot

Fuente: Djerafi T., Doghri Ali. & Wu K. (2015).

La antena Vivaldi fue desarrollada por P. Gibson en 1.979 como un elemento de antena
plana con el cual se puede producir un haz en la salida simétrico, con una ganancia apreciable y
con lobulos laterales pequefios. La antena vivaldi consta de una ranura el el metalizado del
sustrato que se amplia exponencialmente, cuya variacion exponencial es la que determina las

caracteristicas que tendré la antena tanto en directividad como ganancia, otro parametro a tener
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en cuenta en el acoplamiento de impedancia de la linea microstrip, esto puede generar algunos

problemas de no estar bien adaptada lo que repercutira en la operacién de la antena.

Slot line

Tapered

Microstrip line

P
r

Figura 0.2. Antena tipo vivaldi

Fuente: Kerarti, D.Z., Marouf, F.Z., & Meriah, S.M. (2012).
Sus caracteristicas principales son:

eForma parte de las antenas de onda viajera de radiacion longitudinal (endfire
traveling wave antennas)

eBajo costo de produccion

eTiene un gran ancho de banda

ePresenta alta directividad

eProduce patrones simétricos de radiacion

Planteamiento de problema

Debido al vertiginoso avance de la tecnologia con mejoras y cambios, las necesidades de
la sociedad también han evolucionado hacia conexiones mas seguras y de alta velocidad, ademas
por la paulatina saturacién del canal de 2,4 GHz para comunicaciones , ha servido como impulso
para el desarrollo y evolucion de tecnologias que estan dirigidas para mejorar las deficiencias
técnicas, como la baja velocidad de trasmision de datos, falencias que poseen por ejemplo, el
WiFi y Bluetooth que son las tecnologias con mayor expansion para redes de area local, por lo

que, la tecnologia inalambrica UWB se desarrolla con la consigna de solventar estos

2
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inconvenientes, motivando el estudio del disefio de una antena vivaldi que puede ser utilizada
para proveer transmisiones de alta velocidad a poca distancia, ya que posee amplio ancho de
banda, ademas de alta ganancia y baja potencia, lo que la hace ideal para entornos Indoor.
Teniendo presente las caracteristicas mencionadas, para realizar el presente proyecto se
ha tomado en cuenta las especificaciones de la FCC, que dice, que para que se considere
comunicaciones de UWB es necesario cumplir con dos definiciones, el ancho de banda debe ser
> 500 MHz y el ancho de banda fraccional > 20%, tomando estas definiciones se utilizara la

siguiente formula para determinar el ancho de banda fraccional

BW 2(f, — 1))
= xlﬂﬂ%zh—ﬁxm{}%

f hit i

.-II -

Ecuacion 0.1. Férmula para determinar el ancho de banda fraccional

Fuente: FCC, Revision Part 15 of the Commission’s Rules Regarding Ultra-Wideband Transmission Systems
(2002)

Donde:

Bf = ancho de banda fraccional
BW = ancho de banda total

fc = frecuencia central

fh = frecuencia superior

fl = frecuencia inferior

Formula que también servira para determinar el ancho de banda, siendo fh = 3,850 GHz
y f1=3,150 GHz, teniendo como central la frecuencia de 3,5 Ghz, con un ancho de banda de
700Mhz cumpliendo con esto, las especificaciones antes citadas, ademas habiendo escogido la
frecuencia de 3,5 GHz por ser la que se encuentra en el rango de especificaciones citadas, ya
que las recomendaciones de la FCC ha dividido el espectro UWB para diferentes aplicaciones,
se espera ademas no causar interferencia en las frecuencias que opera actualmente , por ejemplo
WiFi, entre las especificaciones que propone la FCC estan que el dispositivo debe estar disefiado
para funcionar solamente en ambientes indoor para lo que se procedera a realizar los célculos

teoricos para el disefio de la antena vivaldi, luego utilizando un software para simulaciones de

3
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onda completa se optimizaran los datos obtenidos hasta logras lo parametros 6ptimos y para
finalizar utilizando la técnica de campo libre y la herramienta VNA (Analizador de redes

vectoriales) obtener los patrones de radiacion, perdidas de retorno y ganancias.

Objetivo General

eIlmplementar una antena del tipo Vivaldi para aplicaciones UWB (Ultra
WideBand, para un ancho de banda de 700 MHz y resuene a 3.5 GHz.

Objetivos especificos

eDisefiar tedricamente los diferentes parametros de la antena Vivaldi a 3.5 GHz
con 700 MHz de ancho de banda.

eOptimizar el disefio teérico mediante un simulador de onda completa.

eElaborar la antena Vivaldi desde los parametros obtenidos en los modelos
teoricos

oValidar el disefio experimentalmente mediante la obtencion de patron de

radiacion, ganancia y perdidas de retorno (Return loss)

Alcance del proyecto

Se recopilara informacion por medio de una investigacion bibliografica de la literatura
existente lo cual permitird conocer los principios y funcionamiento de la antena que se

implementara.

Se realizar& modelos teodricos de la antena vivaldi con los datos recopilados

anteriormente, con lo que se determinara las dimensiones para la simulacién.
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Se utilizara un simulador de onda completa (COMSOL) para realizar la optimizacién
de los modelos teodricos obtenidos y realizar correcciones necesarias antes de la

implementacion.

Con los datos obtenidos de las simulaciones realizar la respectiva implementacion de
la antena para luego realizar un andlisis de parametros que verificara si la antena cumple con

las caracteristicas y parametros deseados.

Descripcion de Capitulos

Capitulo 1

En este capitulo se revisara conceptos, principios tedricos que seran fundamentales
para la realizacion del proyecto, ademas de consolidar los conocimientos que serviran

posteriormente en todo el desarrollo del proyecto.
Capitulo 2
En este capitulo se describe la metodologia que se utilizara para obtener por medio de

la investigacion de la literatura existente los pardmetros y caracteristicas que tendré la antena

del proyecto.
Capitulo 3
En este capitulo de realizard los modelos teoricos de los cuales se desprenderan las

dimensiones que tendra la antena, mismos que serviran posteriormente para la simulacion

en el software COMSOL (simulador de onda completa).
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Capitulo 4

En este capitulo finalmente se describira el proceso y desarrollo para elaborar de forma
artesanal la antena vivaldi desde los datos desprendidos de las simulaciones y se presentara

los resultados del estudio.



CAPITULO 1

FUNDAMENTACION TEORICA

1.1 UWB (Ultra Wideband)

Los sistemas de comunicacion que utilizan UWB proveeran a futuro una gran variedad de
aplicaciones, porque dispone de un ancho de banda considerable, ademas de una amplia
capacidad para transmitir datos a grandes velocidades, y por Gltimo pero no menos importante
bajos costos de implementacion, estos son algunos de los beneficios que tiene la tecnologia
UWAB, sin mencionar ain que contribuiria en gran medida a liberar las transmisiones en rangos
2,4 GHz — 5 GHz que en la actualidad se encuentran bastante saturados. Dichos rangos son los
preferidos para transmisiones WiFi. En Figura 1.1. se puede observar los diferentes rangos y

coberturas de las tecnologias existentes y el lugar en el que esta la UWB.

Wide-area network (WAN)
-Large coverage

~High cost Personal area network (PAN)
: -Connectivity

- Vehicle -Cable replacement

8 -Low cost
= g Walk Local area network access
= o : -Hot speed
2 Stationary “QH igh speed
= “Moderate cost

5

1=

£ [Stationafy |

Mbps

User bit rates

Figura 1.1. Diferentes rangos y coberturas de las tecnologias existentes.

Fuente: M, Di Benedetto, T, Kaiser, A, F. Molisch,l. Oppermann, C, Politano, and D. Porcino, (2006)
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Como ya se ha definido anteriormente la FCC ha publicado los parametros aceptables para
las transmisiones de UWB, las sefiales UWB deben tener anchos de banda superiores a 500
MHz o un ancho de banda fraccional mayor mas del 20% en todo momento de transmision. El
ancho de banda fraccional es un parametro que generalmente se utiliza para definir y clasificar
el tipo de sefial, si es banda estrecha, banda ancha o banda ultra ancha y se mide a -10 dB en

funcion de la frecuencia central. La siguiente ecuacion muestra esta relacion.

AT _f o
BH>HM%=—@LJQQHW%=EngQ

fe Uy + 112 L+,

Ecuacién 1.1. Formas para calcular el ancho de banda fraccional

B. = x 100%

i

Fuente: FCC, Revision Part 15 of the Commission’s Rules Regarding Ultra-Wideband Transmission Systems
(2002)

Donde:

Bf = ancho de banda fraccional
BW = ancho de banda total

fc = frecuencia central

fh = frecuencia superior

fl = frecuencia inferior

donde fh y f1 son las frecuencias de corte mas altas y mas bajas del estudio con las que se
realizara la antena, respectivamente. Una sefial UWB situarse en cualquier lugar del espectro de

radiofrecuencia destinado para estas comunicaciones.

1.2 Caracteristicas de UWB

En torno a la tecnologia UWB existen varias caracteristicas que seran de mucha utilidad

para las comunicaciones que llegan a los consumidores.

etienen una complejidad potencialmente baja y bajo costo

etiene un espectro de sefial similar al ruido;
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eson resistentes a maltiples trayectos severos y atascos;
etienen muy buena resolucion en el dominio del tiempo que permite la ubicacion

y el seguimiento.

1.2.1 Aplicaciones.

Cuando se menciona baja complejidad y bajo costo de la tecnologia UWB, se hace
referencia a una de sus caracteristicas, que tiene que ver con la banda base de transmision.
Mientras los transmisores convencionales necesitan un mezclador RF, las sefiales UWB no,
porque produces pulsos cortos en el dominio del tiempo para propagarse. En las comunicaciones
convencionales en la etapa de mezcla RF generalmente se usa una sefial de banda base, a la que
se le adiciona una portadora lo que hace que la sefial de frecuencia tenga las caracteristicas
necesarias para su propagacion, en cambio el UWB al disponer de frecuencias que generalmente
se usan como portadoras le evita la necesidad de utilizar conversion ascendente, y en el receptor
tampoco necesitaria conversion descendente lo que elimina la necesidad de un oscilador local
en el receptor.

Lo reduce significativamente los costos de implementacion para las aplicaciones que se
pudieran generar para la UWB, aplicaciones que en teoria se implementarian con menos
recursos lo que ayudaria en gran medida a la expansion de la tecnologia UWB en distintos y
muy variados campos de investigacion, como los radares, posicionamiento, transmisiones de

alta velocidad, etc.

1.3 Antenas Vivaldi

La antena Vivaldi es una antena de banda ultra ancha del TSA (Antena de ranura cénica)
que también se conoce como ranura de antena parche, este tipo de antena entra en el rango de
onda viajera, lo que quiere decir que sus parametros tanto corriente como voltaje pueden ser
representadas como ondas viajeras, en 1979 P. J. Gibson ofrecié un nuevo tipo de antena cuya
ranura abierta exponencialmente que se llamo antena Vivaldi, Es por eso que las antenas Vivaldi
también se llaman ETSA (Exponencial conico Antena de ranura). Las antenas Vivaldi pueden

proporcionar anchos de banda a varias octavas. Generalmente posee alta directividad ademas de
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generar patrones de radiacion simétricos. Las antenas TSA (Taped slot antenna) se utilizan en
diferentes tipos de campos de las telecomunicaciones como por ejemplo radares, algunos
dispositivos moviles, sistemas de posicionamiento, debido a su bajo costo de implantacion y

grandes beneficios tecnoldgicos.

A
v

\ 4
>

A

La

Figura 1.2. Diagrama de dimensiones de una antena vivaldi

Fuente: M. Y. Perdanal, T. Hariyadil, Y. Wahyu.(2017)

10



CAPITULO 1 FUNDAMENTACION TEORICA 11

1.4 Parametros basicos de una antena

“Las antenas son dispositivos que irradian y reciben ondas electromagnéticas que se
propagan por el espacio libre, esta es una de las definiciones de antenas publicada por la IEEE
(Standard Definitions of Terms for Antennas).” (IEEE, 1983).

El modo de transmision que se muestra en la figura 1.3 esta representada por un generador
ideal, la impedancia caracteristica es la linea de transmision y la antena representada por una
carga del tipo resistivo.

Conectada a la linea de transmision, que son consecuencia equivalente de los circuitos de
Thevenin y Norton siendo este uno de los pardmetros tedricos fundamentales en el acoplamiento

de impedancias concepto que se utilizara posteriormente en el estudio.

Zy= R+ R, +]Xy

Ecuacién 1.2. Impedancia de una
antena

Fuente: Balanis,(2005)

Ry,
I I
A e TN
: N SN SN S R,

V. () Y N v |
CAN, I\ oy v

[ . \s b | Xy

[ Standing wave [

I I |

l=— Source —f=——— Transmissicn line ————= Antennna =
Ly=(Mp + R+ X,

Figura 1.3. Antena representada por una carga del tipo resistivo

Fuente: Balanis,(2005)
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FE-field

t
Source Transmission line Antenna Radiated free-space wave

Figura 1.4. Formas de propagacién en sus diferentes fases

Fuente: Balanis, (2005)

Para comprender a fondo el funcionamiento de una antena es necesario tener en claro una
serie de parametros que permitira comprender mejor manera el funcionamiento de las mismas,
este conocimiento serd de gran utilidad al momento de desarrollar una antena. Los parametros

mas importantes se describiran a continuacion.

1.4.1 Patrén de radiacion

Un patron de radiacion de antena o patrén de antena se define como una funcién
matematica puede realizar una representacion grafica que abarca de las propiedades de radiacion
de la antena como una funcién de coordenadas espaciales™. En la mayoria de los casos, el patron
de radiacién se determina en el campo lejano y se representa como una funcién de las

coordenadas direccionales.

Las propiedades de radiacion incluyen densidad de flujo de potencia, intensidad de
radiacion, intensidad de campo, directividad, fase o polarizacion. La propiedad de radiacion que
mas preocupa es la bidimensional o tridimensional, distribucion espacial de la energia radiada
en funcidn de la posicion del observador a lo largo de un camino o superficie de radio constante.
(Balanis,2005)

12
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Para tener mas en claro se puede ver en la figura 1.5 diferentes fuerzas que intervienen en

los patrones de radiacion.

Elevation plane

lobe —

Minor lobes =—

Figura 1.5. Patrén de radiacion de una antena

Fuente: C. Balanis, (2005)

1.5.2 Lébulos de patron de radiacion

Varias partes de un patrén de radiacion se denominan l6bulos, que pueden sub clasificarse
en lébulos mayores o principales, menores, laterales y de back. Un l6bulo de radiacion es una
"porcion del patron de radiacion limitado por regiones de intensidad de radiacion relativamente
débil " (Balanis, 2005). La figura 1.6 muestra un tridimensional simétrico patron polar con
varios lobulos de radiacion. Algunos son de mayor intensidad de radiacion que otros, pero todos

se clasifican como l6bulos.

13
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o ) _Major lobe
First null beamwidth | /

\

\

(FNBW)

Half-power beamwidth
(HPBW) Z

Nt

Minor lobes ~___

™ Back lobe
Minor lobes

(a)

Figura 1.6. (a) Diferentes tipos de I6bulos en patron de radiacion

Fuente: C. Balanis, (2005)

A
Radiation
intensity

Half-power beamwidth(tHPBW)

First null beamwidthi FNBW)

_~Major lobe

+ |+

Minor lobes HPBW

Side lobe Back lobe

FNBW

s /2 0 w2 g 0

(h)
Figura 1.7. (b) Diagrama de I6bulos en el patron de radiacion

Fuente: C. Balanis, (2005)

1.5.3 Intensidad de radiacién

La intensidad de radiacion en una direccion dada se define como "el poder irradiado desde
una antena por unidad de angulo solido ". La intensidad de radiacion es un pardmetro de campo
lejano, y se puede obtener simplemente multiplicando la densidad de radiacién por el cuadrado

de la distancia. (Balanis, 2005). En forma matematica se expresa como:

14
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9
U=r"Wug
Ecuacién 1.3. Intensidad de radiacion

Fuente: C. Balanis (2005)

Donde
U= intensidad de radiacion (W/unidad de angulo solido)

Wrad= densidad de radiacién (W/m2)

1.5.4 Directividad

La directividad de una antena definido como "la relacion de la intensidad de radiacion en
una direccion dada desde la antena a la intensidad de radiacion promediada en todas las
direcciones. La intensidad de radiacion promedio es igual a la potencia total radiada por la
antena dividida por 4x. Si la direccion es no especificada, la direccion de la méxima intensidad
de radiacion esta implicita”. Dicho mas simplemente, la directividad de una fuente no isotrépica
es igual a la proporcion de su radiacion intensidad en una direccion dada sobre la de una fuente
isotropica. (Balanis,2005)

U 4nU

D=—=
U() E rad

Ecuacién 1.4. Directividad
Fuente: C. Balanis (2005)

Cuando no se especifica la direccidn se entendera que es la direccion de maxima radiacion

Ulmux Umu.\' 4 Umux
szlx — DO e == =
UO UO Przld

Ecuacioén 1.5. Directividad maxima

Fuente: C. Balanis (2005)

15
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Donde

D= directividad

DO= directividad maxima

U= Intensidad de radiacion (W/unidad de angulo sélido)

Umax= Intensidad maxima de radiacion (W/unidad de angulo sélido)
U0= Intensidad de radiacion isotropica en la fuente

Prad= Potencia total radiada

1.5.5 Eficiencia

Una antena posee varias eficiencias, no obstante, la eficiencia total de la antena, cuya
nomenclatura e0 (eficiencia total) se utiliza para tener en cuenta las pérdidas en los terminales
de entrada y dentro de la estructura de la antena. Dichas pérdidas pueden ser debidas, reflexiones
debido a la falta de coincidencia entre la linea de transmision y la antena, ademas de pérdidas |

2R (conduccidn y dieléctrico). (Balanis, 2005)

N\

to—v Antenna

Input Output
terminals terminals
(gain reference) (directivity reference)

(a) Antenna reference terminals

\

1
&

r i

1
&

/

(b) Reflection, conduction. and dielectric losses
Figura 1.8. (a) Terminales referenciales de una antena, (b) Reflexion, conduccidn y perdidas del dieléctrico.

Fuente: C. Balanis (2005)
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En general la eficiencia puede escribirse matematicamente como:
2 — D 2 2
€) = €r€c€y
Ecuacién 1.6. Eficiencia total de una antena
Fuente: C. Balanis (2005)

Donde

e0 = eficiencia total

er = eficiencia de reflexion = (1 —|T']%)
ec = eficiencia conductual

ed = eficiencia dieléctrica

VSWR -1

' = voltaje de coeficiente de reflexion = Il = 7o~

1+ [T

1 =T

VSWR =

1.5.6 Ganancia

La ganancia describe el rendimiento de una antena. A pesar de gque la ganancia de la antena
estd estrechamente relacionada con la directividad, es una medida que toma en cuenta la
eficiencia de la antena, asi como sus capacidades direccionales. La ganancia de una antena (en
una direccion dada) se define como "la relacién de la intensidad, en una direccién dada, a la

intensidad de radiacion que se obtendria si la potencia aceptada” (Balanis, 2005)

Intensidad _de _radiacion _ Ay U(l,o)
Potencia _total _entrada P

in

Gain=4r

Ecuacioén 1.7. Ganancia de una antena

Fuente: C. Balanis (2005)
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1.5.7 Polarizacion

La polarizacion de una antena en una direccion dada se define como "la polarizacion de
la antena onda transmitida (radiada) por la antena. Cuando no se indica la direccion, se considera
que la polarizacién es la polarizacion en la direccion de ganancia maxima ", la polarizacién de
la energia radiada varia con la direccion del centro de la antena, de modo que diferentes partes

del patron pueden tener diferentes polarizaciones.

La polarizacién de una onda radiada se define como "esa propiedad de una onda
electromagnética para describe la direccion variable en el tiempo y la magnitud relativa del

vector campo eléctrico. (Balanis, 2005)

(a) Rotation of wave

Figura 1.9 Polarizacion de una antena (a)Rotacion de onda

Fuente: C. Balanis (2005)
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Major axis Minor axis

Figura 1.10. (b)Elipse de polarizacion

Fuente: C. Balanis. (2005)

1.5.8 Ancho de banda

El ancho de banda de una antena se puede considerar como "el rango de frecuencias dentro
del cual el rendimiento de la antena, con respecto a alguna caracteristica, se ajusta a un
determinado estandar”. (Balanis, 2005). El ancho de banda debe considerarse como el rango de
frecuencias, ya sea en lado de una frecuencia central (generalmente la frecuencia de resonancia
para un dipolo), donde las caracteristicas de la antena (como la impedancia de entrada, patrén,
ancho de haz, polarizacién, nivel lateral del I6bulo, ganancia, direccion del haz, eficiencia de
radiacion) estan dentro de un valor aceptable de aquellos en la frecuencia central. Para antenas
de banda ancha, el ancho de banda suele ser expresado como la relacién de las frecuencias
superior a inferior de operacion aceptable, por ejemplo, un ancho de banda de 10: 1 indica que
la frecuencia superior es 10 veces mayor que el mas bajo. Para antenas de banda estrecha, el
ancho de banda se expresa como un porcentaje de la diferencia de frecuencia (superior menos
inferior) sobre la frecuencia central del ancho de banda. Por ejemplo, un ancho de banda del 5%
indica que la diferencia de frecuencia aceptable para a operacion es el 5% de la frecuencia
central del ancho de banda.

19
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1.6 Tipos de antenas

Existe gran variedad de antenas que se pueden analizar y mostrar sus diferentes
caracteristicas, como, por ejemplo, antenas de alambre, antenas de apertura y antenas

microestrip.

1.6.1 Antena de alambre

Estas son de los mas comunes tipos de antenas, se puede encontrarlos en diferentes tipos
de lugares como por ejemplo automoviles, radios, naves, aviones, edificios etc., y tienen ademas

diferentes formas, rectas circulares curvas etc.

| -

(a) Dipole (b1 Circular (square loop

(b Helix

Figura 1.11. Tipos de antenas de alambre. (a ) Dipolo, (b) Bucle circular
(c) Espiral

Fuente: C. Balanis, (2005)

1.6.2 Antenas de apertura

Estas son menos conocidas y se utilizan mayormente en naves espaciales y aviones puesto

que se puede colocar en la parte baja de las mismas

20
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(b) Conical homn

(a) Pyramidal horn

(c) Rectangular waveguide

Figura 1.12.Tipos de antenas de apertura. (a) Bocina rectangular, (b) Bocina cénica. (c) Guia
de onda.

Fuente: C. Balanis, (2005)

1.6.3 Antenas Microstrip

Las antenas de microstrip se hicieron muy populares en la década de 1970 principalmente
para aplicaciones en el espacio. En la actualidad el uso de las antenas microstrip estan bastante
difundido y esta presente en diversos productos, las antenas microstrip son parches metalicos
que esta sobre un sustrato, el parche puede tener diferentes formas y tamarios, segun el disefio y

la configuracién necesaria.

Actualmente las antenas microstrip mas conocidas son las antenas de parche circular y
rectangular, que son los que se muestran en la Figura 1.13, esto es consecuencia de que son
antenas faciles de implementar, disefiar y analizar, ademas poseen atractivas caracteristicas en
cuanto a su radiacion. Las antenas de microstrip son de bajo perfil, compatibles con planas y no
planas superficies, simples y economicas de fabricar utilizando tecnologia moderna de circuito
impreso, mecanicamente robusto cuando se monta en superficies rigidas, compatible con
disefios MMIC, y muy versatil en términos de frecuencia resonante, polarizacion, patron e
impedancia. Estas antenas se pueden montar en la superficie de aviones de alto rendimiento,
naves espaciales, satélites, misiles, automoviles e incluso teléfonos moviles de mano.” (Balanis,

2005: 4-5)
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IF: /
ff
f—— | ——/
ff' 1 n
,.r’f Patch T I
/f'
;
4
/
| £, Substrate

Substrate Ground plane

Ground planc (b} Circular
(a) Rectangular

Figura 1.13. Antenas microstrip. (a) Rectangular, (b) Circular.

Fuente: C. Balanis, (2005)

1.6.6 Antenas Vivaldi

La antena Vivaldi es una antena de banda ultra ancha del TSA (Antena de ranura cénica)
que también se conoce como ranura de antena parche, este tipo de antena entra en el rango de
onda viajera, lo que quiere decir que sus parametros tanto corriente como voltaje pueden ser
representadas como ondas viajeras, en 1979 P. J. Gibson ofreci6 un nuevo tipo de antena cuya
ranura abierta exponencialmente que se llam¢é antena Vivaldi, Es por eso que las antenas Vivaldi
también se llaman ETSA (Exponencial conico Antena de ranura). Las antenas Vivaldi pueden
proporcionar anchos de banda a varias octavas. El ancho de banda en este documento pertenece
a S11 que es tipicamente S11 <—10 dB. Los pardmetros S11 o SWR se encuentran entre los
prominentes en disefio de antena. Generalmente posee alta directividad ademéas de generar
patrones de radiacion simétricos.

Las antenas del tipo vivaldi de utilizan en diferentes campos tecnoldgicos y su
investigacion continula vigente ya que ofrece muchas ventajas con respecto a otras tecnologias

similares.

22



CAPITULO 1 FUNDAMENTACION TEORICA

23

Figura 1.14. Diagrama de dimensiones antena vivaldi
Fuente: J. H. Shafieha, J. Noorinia, and Ch. Ghobadi, (2008)
WsL = ancho del stripline de la antena
Wst = ancho del microstrip
Lg = distancia entre el extremo y cavidad circular de la antena
DsL = diametro circular de la cavidad del slotline
R = radio de apertura en el slotline
H = largo de la apertura
b = ancho de la antena
a = largo de la antena
L = largo de la seccién de apertura

t = grosor del sustrato
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CAPITULO 2

MARCO METODOLOGICO

Con respecto al marco metodoldgico que se utilizara para el presente estudio sera el
método logico-deductivo puesto que, se ha de realizar una investigacion bibliografica para
recoger y analizar de la literatura existente, caracteristicas, estandares, datos importantes sobre
el disefio de la antena Vivaldi, a fin de determinar las caracteristicas y parametros 6ptimos de
disefio y posteriormente optimizar del modelo tedrico mediante un simulador de onda completa
(COMSOL).

Ademas del método l6gico-deductivo, se utilizara también el método empirico-inductivo,
puesto que, se realizara el disefio de la antena en base a modelos matematicos y simulaciones,

para posteriormente utilizar los datos obtenidos en la construccién de la antena vivaldi.

2.1 Metodo légico deductivo

Con el fin de obtener la informacion mas relevante sobre los pardmetros éptimos para el
disefio de la antena, se realizara una investigacion bibliografica de fuentes cientificas online,
libros, publicaciones cientificas, proyectos de tesis, y una vez consultados se tomara lo mas

relevante en cuanto a conceptos, métodos que ayuden para el disefio de la antena.
2.2 Método empirico-inductivo
Una vez recopilada la informacion mediante la investigacion bibliogréfica, se utilizara

para fundamentar el disefio de la antena, se realizara un modelo teérico que posteriormente

servira para la simulacion de parametros de la antena, con este proceso se lograra encontrar
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fallas en los parametros del disefio teorico, con el fin de optimizarlos en la simulacién antes de

la implementacion.

2.3 Simulacién y Optimizacién

Para la simulacion se utilizara el software especializado en analisis de diversos tipos de
modelos antenas y proyectos en general, el software en cuestion es uno de onda completa,
conocido en el mercado como COMSOL Multiphysics® Modeling Software, la aplicacion
COMSOL es un software para modelado multifisico, es software de ingenieria de alta
tecnologia.

Con este software se realizaran las simulaciones en las que se optimizaran los diferentes
parametros hasta obtener los resultados deseados, siendo estos posteriormente implementados
para las respectivas pruebas de campo, las mismas que seran llevadas a cabo para obtener los

patrones de radiacion, ganancia y las pérdidas de retorno
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CAPITULO 3

PROPUESTA

En este capitulo del presente estudio se abordara como tema principal los parametros,
calculos y modelos matematicos que permitira realizar la antena vivaldi que es el objetivo
principal del estudio, una vez realizados los calculos de modelos matematicos se podra ingresar
los datos a un simulador de onda completa, en este caso COMSOL, en donde se optimizaran los
parametros para que cumpla el disefio con las caracteristicas deseadas, este paso es de suma
importancia para el estudio, puesto que, los modelos matematicos proveen datos sin tomar en
cuenta algunos parametros que pudieran causar interferencia en la antena y la optimizacion de
la antena en el simulador permitira acercarnos mucho mas a las caracteristicas deseadas para la

antena a implementar.

CONSTRUCCION DE LA ANTENA VIVALDI

3.1 Disefio de la antena Vivaldi
Tomando en cuenta consideraciones de caracter técnico recopilados en la investigacion
bibliogréafica, se procedera con la elaboracion de los modelos matematicos de la antena vivaldi,

cuya implementacion es el objetivo del presente estudio.

Uno de los parametros mas importantes a la hora de disefiar una antena Vivaldi, o
cualquier antena con alimentacion microstrip es la eleccion del sustrato, para que cumpla con
las especificaciones deseadas, razon por la que, la longitud , el espesor, la constante dieléctrica
no son factores que se pueden dejar al azar y deben ser calculados, afortunadamente existe una

férmula postulada por Yngvesson la cual estima que el grosor efectivo del sustrato normalizado
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con respecto a la longitud de onda en el espacio vacio (frecuencia central) debe estar entre 0.005
y 0.03, aunque otros estudios la sitian en 0.006.

Ademas, se debe tener adicionalmente en cuenta que la constante dieléctrica que se elija
repercutird en el disefio ya que con una constante dieléctrica baja se tendra en el slotline una
impedancia alta lo cual dificultard adaptar la alimentacion, y en cuanto al grosor incide en la
obtencion de I6bulos en la radiacion de la antena mientras mas grueso es el sustrato los I6bulos

aumentaran su magnitud, en cambio si es delgado los I6bulos tienden a ensancharse.

3.1.1 Grosor del sustrato, calculo del grosor eficaz

Para realizar el calculo de heff se hara con una formula, la cual permitira verificar si los
parametros escogidos se encuentran dentro de los rangos aceptables.

Los sustratos elegidos como parametros para las simulaciones son los siguientes el FR4
del tipo RO4003C, RO4725, RO4730 y el FR4 de constante dieléctrica 4,4 con caracteristicas

que se detallan en las Figuras 3.1, 3.2 y 3.3 obtenida de Roger corporation.

Cabe anotar que estos tipos de sustratos se utilizaran para las simulaciones de los cuales
se tomaré posteriormente el que mejor y mas accesible, y que responda a las pruebas para la

respectiva implementacion.

Typical Value Direction Condition Test Method
RO4003C RO4350B
Dielectric Constant, g, IBC-TM-650
3 ! i 3.38 £ 0.05 *3.48  0.05 z 10 GHz/23°C 2.5.5.5
Process Y
Clamped Stripline
®) Dielectric Constant, g, Differential Phase
Design 555 3:66. z B:t0:40.Ghz Length Method
T 0.0027 0.0037 7 10 GHz/23°C IPC-TM-650
P . 0.0021 0.0031 2.5 GHz/23°C 2.5.5.5
Thermal Coefficient of e, +40 +50 z ppm/°C -50°C to 150°C upcz-"rsms-ssso
Volume Resistivity 1.7 X 10 1.2 X10%° MQe-cm COND A IPCIM 659
2.5.17.1
Surface Resistivity 4.2X10° 5.7 X10° MQ COND A e IMio50
251172
: 31.2 31.2 KV/mm 0.51mm IPC-TM-650
ElectsicalStrengh (780) (780) “ (V/mil) (0.0207) 2.5.6.2
. 19,650 (2,850) | 16,767 (2,432) X .
Tensile Modulus 10,450 (2.821) | 14153, (2.053) 7 MPa (ksi) RT ASTM D638
. 139 (20.2) 203 (29.5) X .
Tensile Strength 100 (14.5) 130 (18.9) 5 MPa (ksi) RT ASTM D638
276 255 MPa IPC-TM-650
Flexural Strength (40) 3B7) (kpsi) 2.4.4
2 : S mm/m after etch IPC-TM-650
Dimensional Stability <0.3 <0.5 XY (mils/inch) JEnjAtoec S.A50R

Figura 3.1.Datasheed de sustratos para simulacion

Fuente: ROGER Corpotration.com, (2020)
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Typical Value Typical Value Typical Value
[ )| 1]

Property Direction Units Condition Test Method
RO4725JXR RO4730JXR RO4730G3
Dielectric Constant, = Process 255+005 | 300£005 | 3.00+005 z 10 GHZ/23°C IPCTM-650, 2.5.5.5
.
Dielectric Constant, =, Design [3] 264 298 298 z 17 8;'?12 = Dlﬁerentﬁngée Length
0.0026 0.0027 0.0029 10 GHz/23°C
Disslpation Factor [4] z IPC-TM-650, 2.5.5.5
0.0022 0.0023 0.0023 2.5GHz
Thermal Coefficlent of =, +34 +32 +26 Z ppm/°C | -50°Cto 150°C IPC-TM-650, 2.5.5.5
Volume Resistivity (0.030") 216X 10° 596X 10° 478x10° MQ.cm CONDA IPC-TM-650, 2.5.17.1
Surface Resistivity (0.030") 48X107 1.68 X 10° 278x10° MQ COND A IPC-TM-650, 2.5.17.1
50 ohm 43dBm
PIM[2] -166 -164 -165 dBc 0.060" 1900MHz
Electrical Strength (0.030") 630 21 762 Z V/mil IPC-TM-650, 2.5.6.2
Flexural Strength MD 121(17.5) 167 (24.2) 200(303)
1 e RT ASTMD790
CMD 92(133) 135(19.6) 152(22.1)
Dimensional Stability <04 <04 <04 XY mm/m | 2fteretch IPC-TM-650, 2.4.30A

Figura 3.2.Datasheet de sustratos para simulacion

Fuente: ROGER Corpotration.com, (2020)

LoPro Copper LoPro Copper LoPro Copper ED Copper 12°X187(305 X 457 mm) LoPro Reverse Treated EDC Foil
0.0307"(0.780mm) 0.0207"{0.526mm) 0.0057" (0.145mm) 0.0200" (0.508mm) 24°X 187(610 X 457 mm) % 0z (18um), 1 0z (35um)
0.0607"(1.542mm) 0.0307" (0.780mm) 0.0107"(0.272mm) 0.0300"(0.762mm) 24°X36"(610 X915 mm)

0.0407"(1.034mm) 0.0207° (0.526mm) 0.0400"(1.016mm) 48°X36"(1.224m X 915mm) Standard EDC (R04730G3 only)
0.0607"(1.542mm) 0.0307* (0.780mm) 0.0500" (1.270mm) Larger sizes may be available % 0z (18um), 1 0z (35um)
0.0407° (1.034mm) 0.0600" (1.524mm)

0.0607° (1.542mm)

Figura 3.3. Diferentes tipos de grosores de sustratos
Fuente: ROGER Corporation.com, (2020)

Se comprobara con cada sustrato expuesto anteriormente para determinar si es til para el

presente estudio, ejemplo,

33-1
= u*0.001524 = 0.01451 0.005< A, <0.06
S 0.005 < 0.01451 < 0.06

hy = (—\/6:’“0_ l) *h

Ecuacion 3.1. Grosor effectivo

Fuente: K C. Gupta (1996)
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Tabla 3.1 Calculo de heff para los sustratos

2,55 0.010612

3 0.013015
3.3 0.01451
4.4 0.019515

Fuente: Elaborado por el autor

Después de realizar los calculos para el grosor de 1.524 mm se puede ver que todas las
constantes dieléctricas cumplen con lo establecido por la formula, asi que cualquiera que se

escoja estara dentro de los rangos aceptables.

3.1.2 Disefio tedrico del Slotline (Ranura)

Segun, Cohn (1968) un slotline es una estructura de transmision en antenas planares, su
configuracién basica consiste en un sustrato dieléctrico gravado como una angosta ranura en la

metalizacién del mismo sustrato dieléctrico.

Un slotline puede también incluir un microstrip gravado en la tierra del sustrato, este tipo

de configuracion permite flexibilidad en el disefio de circuitos microondas.

En el slotline las ondas se propagan a través de la ranura, esto hace que el campo eléctrico
que cruce a través de la metalizacion del sustrato dieléctrico, este modo de propagacion es non-
TEM, por lo que la propagacion no esta solamente en el sustrato sino se propaga a través del
espacio (aire).

s VA
n| —fwp— ¢
T — b —

Figura 3.4. Configuracion Slotline o ranura
Fuente : K. C. Gupta, (1996)
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------ MAGNETIC FIELD LINES
————— ELECTRIC FIELD LINES

Figura 3.5. Campos magnéticos y electromagnéticos en un slotline
Fuente: K. C. Gupta, (1996)

Existen varios tipos de analisis y disefios de slotlines, pero como se menciono
anteriormente para el método de propagacion de un slotline las ondas se propagan por la ranura
y por el aire por lo que se debe calcular su Eeffs, para lo que se utilizara la siguiente ecuacion

@ g, +1 ® 4 [2

E . = —
@ = 5 2, "z

Ecuacion 3.2. (a)Constante dieléctrica efectiva, (b)longitud de onda

Fuente: K. C. Gupta (1996)

Para empezar, se debe calcular la longitud de onda guiada a través de la ranura (slotline)
para lo cual se necesitaran parametros que se han mencionado con anterioridad al iniciar este
estudio, como son, la constante dieléctrica, el grosor del sustrato mencionado en el calculo de
Effs de la ecuacion 3.2. asi como la frecuencia de trabajo a la que resonara nuestra antena, para

lo que se utilizaran las siguientes formulas que se han obtenido de la literatura existente (K. C.
Gupta 1996)

3 (%) g, 0945

; 8,81(&, + 0,95) h
w
238,64 + 100

L )
100e, T

2
% =1,045 — 0,365Ln(e,) +

—10,148 —
: |

Ecuacioén 3.3. Longitud de onda del slotline

Fuente: K. C. Gupta (1996)
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T 603,695 ((ET . 222)”) +133,5Ln(10s,) |—
0s = ZAEH T i e T
w 100h
+2,81[1-0,0116,(448 + Ln(e)] Ln( ; )
0

w
+131,1(1.028 — Ln(e,)) o+ 124801
0

w
h

+ 0,18Ln(g,)) —
& — 2,06 + 0,85

Ecuacién 3.4. Impedancia del slotline
Fuente: K. C. Gupta (1996)

3.1.3 Disefio tedrico de la linea microstrip

Uno de los principales requerimientos para que una estructura de transmision sea adecuada
como un circuito de elementos en circuitos integrados de microondas (MICs), es que la
estructura sea de configuracion planar. Esto implica que debe ser determinada en dimensiones
de un solo plano, por ejemplo, el ancho de una linea microstrip en un sustrato dieléctrico debe
ser ajustado para controlar la impedancia, esto quiere decir que cuando el disefio del circuito
puede ser controlado por pardmetros en una sola dimensién puede ser llevado fuera para ser

fabricado por técnicas de litografia, esto abarata costos.

Figura 3.6. Configuracion de una linea microstrip
Fuente : K. C. Gupta, (1996)
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&, +1 g1
8({[7)71 = 2 + h

2, /1+12—
w
Ecuacion 3.5. Epsilon efectivo del microstrip

Fuente: K. C. Gupta (1996)

La longitud de onda se puede obtenerla con la siguiente formula

A
_ 0
/1/11 ==
v Eefim

Ecuacion 3.6. Longitud de onda del microstrip

Fuente: K. C. Gupta (1996)

Se debe tener en cuenta, que para el disefio del microstrip, la antena que debe acoplarse
facilmente a las demas impedancias por lo que se fijard la impedancia caracteristica a 50 Q, y
para el calculo de la misma se puede utilizar las siguientes formulas obtenidas de la literatura
existente. (K. C. Gupta 1996)

8e w
w N m para T <

B 12 & —1 0.61 w
—|B—-1-In(2B-1 {1 B—-1)+0.39 - }] —>2

o n( )+ 5, n( )+ . para —

donde A =Zom [Zril , &1 (0 23 + 0'11)
60 2 e+1\ &
_ 377n
2ZomVer

Ecuacion 3.7. Formula para calcular el ancho del microstrip

Fuente: K. C. Gupta (1996)

Para fines de estudio en la practica también se puede obtener datos de la linea microstrip
con la ayuda de una herramienta especializada que es de cddigo abierto (Open source) llamada
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QUC’s estudio, misma que al ingresar los datos de pardmetros ayudara con los resultados para

el disefio de la antena.

w Frequency 3.5
]
: L L 27.2383 [om_ v |
IT H 0 50| ohms
Angle 188.335 degree
Skin Depth: 1.11571 pm
er 3.38 z_reff: 2.70647
tand 263 Conductor Losses: 0.0138823 dB
o Dielectric Losses: 0.0250684 dB
Resistivity 1.72e-8 Radiation Losses: 0.129001 dB
ure 0.999994 Single-Mode Range: 0Hz ... 19.9 GHz
T 35 |ugm ¥ [ Copy to Clipboard inclusive Circuit ]
H 1.524 [mm ¥

Figura 3.7. Calculos de una linea de transmisién microstrip realizada en Qucs studio

Fuente: Qucs Studio, Captura del autor

3.2 Dimensiones tedricas de la antena vivaldi

Modelo matematico para la construccion de la antena

En teoria, las antenas de ranura conica generalmente tienen un ancho de banda amplio,
alta directividad y pueden producir un patron de radiacion simétrica. También es una estructura
de alimentacion simple y facil de fabricar. Para la realizacion de los modelos matematicos se
debe entender que estos son interpretaciones de las variables mas relevantes que se investigan

para conocer la incidencia de los mismos dentro de un proyecto.

Para el desarrollo de los modelos matematicos primero se debe identificar las variables
principales como son el analisis de la ranura de la antena también conocida como slotline o
ranura conica, esta se construye sobre la metalizacion de un sustrato cuya constante dieléctrica

también es relevante para el estudio.

El disefio de la ranura es se lo realiza en la capa conductora de cobre u otro material

empezando por el ancho minimo de la ranura, ranura que se expandira exponencialmente hasta
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su rango maximo, el principio mas estrecho de la ranura puede alimentarse con una linea

microstrip, para determinar estos parametros se utilizard las ecuaciones consultadas en la
literatura existente

Para obtener las dimensiones que tendréa la antena se utilizara las siguientes formulas.

c

Ag = ——
4 min\/5

Ecuacion 3.8. Apertura tedrica maxima

Fuente: N. hamzah, K. A. othman, (2011)

Donde
Ag = Apertura tedrica maxima
fmin = frecuencia minima
C = velocidad de la luz
Er = constante dieléctrica del sustrato

Para calcular el ancho méximo se empleard la siguiente formula

&g

I/Vmalx - 2
Ecuacién 3.9. Ancho maximo de antena

Fuente: N. hamzah, K. A. othman, (2011)

Y para el ancho menor la siguiente formula

N

min ~ . [
f 0 gr

Ecuacion 3.10. Ancho minimo de antena
Fuente: N. hamzah, K. A. othman, (2011)
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Del slotline o ranura conica es la que le da la forma caracteristica a la antena e incidira en
la forma que radiara la antena, la longitud del cono dependeré en gran medida de la longitud de

onda de la frecuencia més baja y la longitud de la antena.

Estos parametros pueden ser calculados con las formulas que se detallan a continuacién

1 ¥V, ¥, o e y, — o ¥,

RX - RY
e’ —e™

RX ’ RX,
J— e 1 e r

Ecuacién 3.11. Calculo de constantes para la exponencial de la ranura
Fuente: S. Shukla, N. Upadhyay, S. Sharma and N. Hemrajani, (2013)
1 Rx al
Y=Cle™ +(C2
Ecuacién 3.12. Formula para la curva exponencial dela ranura

Fuente: S. Shukla, N. Upadhyay, S. Sharma and N. Hemrajani, (2013)
Donde:
C1y C2 son constantes
R = factor exponencial
Y1>Y2 son los puntos en que empieza y termina el slotline

** (n2)

r.21) y

A 4

Figura 3.7. Puntos de principio y fin teérico del slotline
Fuente: TIOSJCHUTEJIbHAS 3AIIMCKA, (2017)
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Para un calculo aproximado de los parametros de la antena vivaldi se usaran las siguientes
férmulas.

Para lo cual se necesita el rango de frecuencia para el cual funcionara la antena vivaldi y
como se especifica en los apartados anteriores es:

Frecuencia central Frecuencia maxima Frecuencia Minima
F0=3.5 GHz Fmax= 3.850 GHz Fmin=3.150 GHz
C . C

A max = —— Amin = —

J min f max

i A min+ A max

I> A min+ A max W y

2

Ecuacion 3.13. Férmulas para el calculo de dimensiones aproximadas de la antena

Fuente: R. Dhawan and G. Kaur (2016)

Para los valores aproximados de L Y W que se tomaran como referencia para las
simulaciones estan en el siguiente desglose de datos, cabe anotar que los valores deben ser
mayores a los calculados.

Tabla 3.2 Dimensiones calculadas para la antena

L >87mm
W >44mm

Fuente: Elaborado por el autor

Para la apertura radiante de la antena que se calculara con las formulas siguientes, que
fueron definidas anteriormente para el estudio.

C W min = ——

Ecuacién 3.14. Formulas para el célculo de la apertura radiante

Fuente: N. Hamzah, K. A. Othman, (2011)
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Tabla 3.3 Valores obtenidos para la apertura radiante

Constante dieléctrica Ag Wmax Wmin
2,55 59.6 mm 53.6 mm 29.8 mm
3 54.9 mm 49.48 mm 27.45mm
3,38 51.8 mm 46.62 mm 25.9 mm
4.4 45.4 mm 40.84 mm 22.7 mm

Fuente: Elaborado por el autor

De los valores descritos se han de tomar como referencia para el disefio de la simulacion
de la antena en COMSOL, ya que los rangos de las dimensiones son bastante parecidos, se

tomara un valor promedio de 50 mm para la apertura de la antena.

3.3 Disefo de la antena Vivaldi

Con los datos y parametros obtenidos con los calculos anteriormente descritos, se puede
empezar con el disefio de la antena en un software especializado de simulacion de onda
completa, se optara, como se ha mencionado anteriormente, por la utilizacion de un programa
llamado COMSOL por su versatilidad a la hora de disefiar los proyectos con antenas para

posteriormente imprimir los resultados del estudio.

Figura 3.8. Medidas de Antena Vivaldi (COMSOL)
Fuente: Captura del autor
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3. 3.1 Software para la simulacién

De la gran variedad de software para simulacion se puede obtener gran informacion en
cuanto aventajas y desventajas a la hora de utilizarlos, se mostrara los diferentes tipos de

programas que pueden ser de gran utilidad para este tipo de proyectos.

Antena Magus

Antena Magus es un software para acelerar el proceso disefio y modelado de una antena,
es un software que sirve para el mejoramiento de antenas tanto para ingenieros como para
estudiantes, ya que ofrece gran variedad de opciones para el desarrollo de los proyectos, la
mayor desventaja es que es demasiado costoso.

Software Ansys HFSS

Es un software de simulacion de onda completa que provee fiabilidad, calidad en los
procesos de optimizacion, puede realizar andlisis de interferencias radio magnéticas, ademas de
permitir analisis completos de radiofrecuencia, la mayor desventaja de HFSS es la dificultad
que ofrece al momento de manipular el software y que algunas de sus caracteristicas debe

adicionarse posteriormente, no posee una gran libreria.

COMSOL Multiphysics® Modeling Software

Es un software que ofrece capacidades superiores para la optimizacion y disefio de
dispositivos de radiofrecuencia, entre las caracteristicas mas importantes esta que puede simular
el parametro Sy coeficientes de reflexion, VSWR, todos simulados en una gran variedad de
frecuencias, ademas su interfaz es bastante intuitiva a la hora de realizar los proyectos, por lo
que este software ayudara en gran medidas a la obtencién de datos para el presente proyectos y
las graficas que se obtendras ayudaran bastante en el analisis de parametros de la antena

posteriormente en el Capitulo 4.
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Una vez determinado el software para la simulacién se ingresaran los datos para realizar

la respectiva simulacion

Tabla 3.4 Dimensiones para la simulacion

L 100 mm

W 60 mm
Apertura 50 mm
Ws 0.5mm
Radio 8 mm
Union Slotline 20 mm

Fuente: Elaborado por el autor

3.3 Simulacién de los modelos tedricos obtenidos

El primer paso antes de comenzar con el disefio de una antena en el simulador de onda
completa COMSOL es ingresar los parametros a utilizar para cada constante dieléctrica que se
ha escogido para el proyecto, al tener todos los célculos necesarios con las férmulas

mencionadas se procedera a ingresar los datos en el simulador.

Uso de COMSOL Multiphysics® Modeling Software

Como ya se ha mencionado todas las caracteristicas que ofrece para la realizacion del

proyecto, estas seran de gran utilidad para realizar las simulaciones.

Primero se debe configurar los parametros basicos el tipo de proyecto, en este caso
radiofrecuencia, luego ondas electromagnéticas en el dominio de la frecuencia se agrega el
proyecto, se inicia un estudio de proyecto en el dominio de frecuencia y aceptar, ya se puede
iniciar la configuracion basica, como las unidades que se manejard todo el disefio en todo

momento, en este caso mm (milimetros).

Se puede poner algunas variables para facilitar el disefio en definiciones globales esto

permitird que estén listas para utilizarlas.
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kil Settings [l Model Library | % Material Browser Bl | @ = 8]ch Graphics =
A Geometry xec@E-|laQRedlrhzklcacBaes

- Units @) @
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Angular unit:
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Scale values when changing units
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Geometry representation:
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Figura 3.9. Unidades de medidad para el disefio

Fuente: Captura De Comsol (realizada por el autor)

Con las medidas propuestas en los apartados anteriores se coloca las medidas que tendra
el sustrato tanto en L, W, Ws (inicio de ranura), radio y apertura radiante, con estos datos se
obtendra la forma basica de la antena a simular, cabe anotar que se debe realizar el disefio de

cada figura geométrica por separado y unirlas posteriormente para que funcionen como un todo.

» Parameters x®C@E-|QaQqd@lnkleaol@e s
¥
« Parameters ... &
Narne Expression Value Description
grosos 60[mil] 0001524 m grosor del sustrate I - - /—_—\ T
ranura 0.5[mm] 5.0E-4 m grosor inicic de ranura H/ ‘,,»-""'7__7'"““\\ \
L 100 [mm] 0lm large \__ N
w 60 [ram] 0.06 m ancho AU AN
apertura 50 [mm] 0.05m apertura radiante ‘l | . e " Il‘
union 20 [mm] 002 m 7\| ‘I L,” :*x_\_\\ | I‘
radio 8 [mm] 0,008 m radio union / /
v NN A
\ S~ : /
— X \

Figura 3.10. Medidas generales para el disefio de antena vivaldi

Fuente: Captura Comsol Software (Realizada por el autor)

Se continuara con los limites exteriores de la simulacién que comprende los dominios de
radiacion y campo electromagnéticos los cuales serviran posteriormente para la obtencion de
resultados y graficas de la antena, este paso es de suma importancia puesto que, esta cubierta

sera la que hard las funciones de una cdmara anecoica.
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Geometric entity level: [Domain -

Selection: [ domains -

2 I

El B =

4 A

5 E

6 (overridden)
7 (overridden)
8

|'» Override
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Basic Properties
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Piezoelectric Models

Acoustics
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Figura 3.11. Dominio de radiacion
Fuente: Captura Comsol Software (Realizada por el autor)
Se escogera los materiales y pondréa una linea de alimentacién virtual para dar inicio a la

simulacion, los materiales que se utilizaran como ya se ha dicho, es el sustrato FR4 de 4.4y
grosor de 1.524 mm (1.6), y la alimentacién virtual a 50 ohms.

il settings [} Model Library | #§ Material Erowser| G = O[eh Graphics =g
& Material - Qﬁe:i'laaﬁl‘:‘|'\IJ'MBE‘G‘C}@@@@|

Geometric entity level: [Dnmain

Selection: [Manual

6
7

"+ Override

|+ Material Properties

Basic Properties
Electrochemistry
Electromagnetic Models
Solid Mechanics
Piezeelectric Models
Acoustics

Gas Models

Figura 3.12. Material y conector virtual para la simulacién

Fuente: Captura Comsol Software (Realizada por el autor)
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Antes de realizar el calculo final de parametros para la simulacién se verificara la
construccion general de la simulacion y los diferentes parametros, la verificacion se la realiza
con el parametro estudio que es el que calculara todos los datos para cada frecuencia los que

conformara la solucién 1 de la que se desprendera cada una de las graficas obtenidas.

id Settings [} Model Library | % Material Browser | @ = 5)ch Graphics =0
& Mesh x® CE~|R QMR & L-~lylelz|a@ @ ® @
+ Mesh Settings &) &
Sequence type:
[Physics-controlled mesh -
Element size: o
[coarse 7] w00
|
|
1
o
|
|
|
1007
100
z
v L', o

Tne

Figura 3.13. Malla entramado electromagnético de la antena vivaldi

Fuente: Captura Comsol Software (Realizada por el autor)

3.5 Presupuesto para el proyecto

En cuanto al presupuesto para el presente proyecto, al ser una antena vivaldi de bajo costo,
para la implementacion de la misma, se opt6 por el uso de un sustrato FR4 con una constante

dieléctrica de 4,4 con pérdidas tangenciales de 0.2 y grosor de 1,524 mm por ser de facil
adquisicion y disponibilidad en el mercado.

Ademas del sustrato FR4 serd necesario conectores SMA, cloruro férrico, marcador

indeleble, estafio, pasta para soldar, ademas de otros gastos que se detallaran a continuacion.

Tabla 3.5 Presupuesto y comparacion de precios

Producto Precio de compra en Precio de otro proveedor
megatronic
Sustrato FR4 8 USD 10 USD
Conectores SMA 5 USD 6 USD
Cloruro férrico 1 USD 1 USD
Marcador indeleble 1,50 USD 2 USD
Estafio 2USD 2USD
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Pasta para soldar 1 USD 1 USD
Sierra para corte 5USD 5USD
Cautin 60w 10 USD 15 USD
Movilizacién 30 USD 30 USD
Envio online 3 USD 10 USD
Total 66,5 USD 82 USD

Fuente: Elaborado por el autor

Como se puede observar el costo de implementacion para la antena es relativamente bajo

y esta es otra ventaja de las antenas vivaldi su bajo costo de produccion.

A continuacion, se detalla el tiempo empleado para el presente proyecto.

Tiempo dedicado para realizar el proyecto

Tabla 3.6 Tiempo utilizado para realizar el proyecto

Actividad Tiempo
Investigacion en fuentes bibliogréficas e internet 50 horas
Asesorias 20 horas
Desarrollo tedrico del proyecto 20 horas
Desarrollo de simulaciones 30 horas
Implementacion del proyecto 12 horas
Redaccion del presente proyecto 72 horas
Total 204 horas

Fuente: Elaborado por el autor
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IMPLEMENTACION

4.1 Desarrollo

Después de la realizacion de las simulaciones pertinentes y obtencion de datos de las
mismas se ha de usar estos datos para escoger la mejor opcion para la implementacion de la
antena, la cual debe cumplir con las especificaciones técnicas y de factibilidad para que se ajuste
a las necesidades de este proyecto, razon por la que se empezara con una breve descripcion de

los materiales a utilizarse.

Sustrato FR4

El sustrato a utilizarse serd un Sustrato FR4 doble cara, con una constante dieléctrica de
4.4, cuyo grosor es de 1.524 mm y con pérdidas tangenciales de 0.2, esta eleccion responde

mayormente a la disponibilidad actual del sustrato para las pruebas e implementacion.

Figura 4.1. Sustrato FR4 doble cara

Fuente: spanish.alibaba.com
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Tabla 4.1 Resumen de datos del sustrato FR4

Constante dieléctrica 4.4
Perdidas tangenciales 0.2
Grosor 1.524 mm

Fuente: Elaborado por el autor

Conectores SMA

Los conectores que seran necesarios para la implementacion seran un conector de RF tipo
SMA hembra para borde impreso. Ideales para impresos de 1.6 mm de espesor. Usado
comunmente para conexiones de Antena, en aplicaciones como GPS, Telemetria, control

remoto, celular, etc.

Figura 4.2. Conectores SMA

Fuente: Electrolab.co

Tabla 4.2 Caracteristicas técnicas del SMA

Impedancia 50 Ohm
Frecuencia 0a6GHz
Longitud 13 mm
Longitud de la punta 4 mm
Material del conector Cobre

Fuente: Elaborado por el autor
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Impresora laser o marcador indeleble

Para el grabado en la placa se puede utilizara un proceso de grabado por calor utilizando
una impresora laser y marcador indeleble, aunque el proceso de impresion es mucho mas facil
y versatil, usar un marcador permite gran libertad para desarrollar el disefio en el sustrato, pero

también puede causar algun fallo en el disefio.

Cloruro Férrico

Acido utilizado para el grabado de circuitos impresos cuya activacion es realizada con
agua y ademas se debe tomar algunas medidas de seguridad como el uso de guantes, gafas y
recipientes plasticos resistentes, porque es bastante corrosivo, motivo por el cual se debe tener
cuidado al en el tiempo de exposicion con el sustrato.

Figura 4.3. Cloruro Férrico

Fuente: Importronic.com

4.2 Implementacion de la antena Vivaldi

Para la construccion misma de la antena se realizara siguiendo la forma mas habitual y

artesanal, se utilizara los materiales antes descritos para el efecto.
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El grabado se los realiza en el sustrato FR4 para luego llevarlo a el cloruro férrico y

posteriormente realizar el grabado de la antena en el sustrato.

Se ha de considerar los métodos disponibles para la construccion de la antena Vivaldi en los
cuales figura método de grabado por marcador indeleble y por otro lado impresion laser que se
graba en la placa por medio de calor, ambos métodos comprobados y eficaces a la hora de
realizar este tipo de proyectos.

Para facilitar las mediciones de parametros se realizan dos antenas iguales las mismas que

seguiran el método a continuacion descrito.

1. Limpieza para mejorar el grabado de la antena en el sustrato, este paso es bastante
importante ya que cualquier impureza dificultara el grabado en la placa ocasionando

reacciones indeseables para el proyecto.

Figura 4.1. Limpieza del sustrato para el grabado

Fuente: Realizado por el autor

2. Grabado con retoque de tinta para que el &cido retire el material sobrante, el material una
vez limpio se marcara con el disefio propuesto para su grabado, como se ha dicho antes,
el marcador permite libertad a la hora de realizar el disefio, pero hay que tener mucho
cuidado para que el gravado sea uniforme y no cause problemas al ahora de sumergirlo
en el &cido (cloruro férrico).
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Figura 4.2. Grabado de tinta en sustrato
Fuente: Realizado por el autor

3. Antena terminada limpia y con sus respectivos componentes para la medicion.

Figura 4.3. Antena terminada

Fuente: Realizado por el autor
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4.3 Resultados de la simulacién

Con los datos obtenidos se ha obtenido los siguientes resultados que se dividiran por

sustratos estudiados para mejorar la visualizacion de los resultados

Tabla 4.3 Sustrato para simulacion constante dieléctrica de 4.4

Constante dieléctrica

Grosor del sustrato

3.38
1.524 mm

S-parameter (dB)

Y,\I/'x

L L
2 3

)
Frequency (GHz)

Figura 4.1. Parametro S (3.38)
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Figura 4.4. Gréafica VSWR (3.38)

Fuente: Capturas realizadas por el autor desde COMSOL

En las gréaficas expuestas se puede observar que el parametro S11 no es tan bueno, pero

es aceptable, pues esta en el rango de -12 dB, su ancho de banda es aproximadamente de 300
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MHz a -10 dB, y el VSWR de la antena a 3.5 GHz es menor a 2, por lo que esta simulacion no

cumple con las expectativas del proyecto.

Tabla 4.4 Sustrato para simulacion constante dieléctrica de 4.4

Figura 4.8. Patrones de radiacion 3D (4.4)

freq (GHz)

Figura 4.7. Gréfica VSWR (4.4)

Fuente: Capturas realizadas por el autor desde COMSOL

De los datos obtenidos de la simulaciéon para 4.4, también se desprende informacion
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interesante como se puede ver su pardmetro S no es bueno su magnitud es baja, y el VSWR para
3.5 GHz esta cercano a 2, aunque para las demas frecuencias es alto.
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Tabla 4.5 Sustrato para simulacion constante dieléctrica de 3
Constante dieléctrica 3
Grosor del sustrato 1.524 mm
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Figura 4.11. Patrdn de radiacion 3D (3)
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Figura 4.12. Gréfica de VSWR (3)

Fuente: Capturas realizadas por el autor desde COMSOL

Analizando las graficas obtenidas se puede verificar que para este tipo de sustrato el

parametro S es de -12 dB, el ancho de banda medido a — 10 dB seria aproximadamente de 200

MHz, el VSWR para 3.5 GHz es menor a 2, para los demas valore es bastante alto.
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Tabla 4.6 Sustrato para simulacion constante dieléctrica de 2.25

Constante dieléctrica 2.25
Grosor del sustrato 1.524 mm
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Figura 4.15. Patron de radiacion 3D (2.25) Figura 4.16. Grafica VSWR (2.25)

Fuente: Capturas realizadas por el autor desde COMSOL

Se puede observar como al variar los parametros del sustrato se puede obtener grandes
cambios en el comportamiento de la antena, mejora el parametro S y su grafica de VSWR
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notoriamente se mantiene bajo el rango promedio de 2, pero su ancho de banda medido a -10
dB no es el esperado.

Una vez realizadas las simulaciones y analizado los datos expuestos, se realiza algunos
ajustes en los parametros en funcion del sustrato elegido previo a la implementacion obteniendo
las siguientes graficas de COMSOL, graficas que se analizaran junto con los resultados
obtenidos con el analizador de campos vectoriales (VNA).

Global: Voltage standing wave ratio (1)
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Figura 4.23 Gréficas obtenidas previo la implementacién

Fuente: Realizado por el autor en COMSOL
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4.4 Resultados del estudio

Después de realizar los modelos tedricos anteriormente expuestos y con cuyos resultados
se realiza las simulaciones, mismas que serviran para la obtencién de los datos para el

mejoramiento y optimizacion de parametros de la antena a implementar.

Se puede verificar que los parametros finales escogidos de la simulacién cumplen con las
especificaciones deseadas, después de analizar los resultados obtenidos de las simulaciones se

concluye con las dimensiones que se implementara la antena.

Tabla 4.7 Dimensiones para la implementacion

L 100 mm

w 60 mm
Apertura 50 mm

Ws 0.5mm
Radio 8 mm
Union Slotline 20 mm

Fuente: Realizada por el autor

Con estos parametros se elaboré la antena que se presenta ya con sus conectores para las

pruebas de campo con un VNA.

Figura 4.24. Antena vivaldi implementada

Fuente: Realizado por el autor
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4.5 Pruebas de funcionamiento

4.5.1 Caracterizacion de la antena vivaldi

Para la caracterizacion de la antena vivaldi sera necesario la utilizacion de un instrumento
de medicién especializado conocido como VNA (analizador de redes vectoriales), este
instrumento permite verificar las condiciones en las que opera la antena a medir, para asi
establecer sus caracteristicas técnicas principales, como son parametro S, carta de Smith, grafica
VSWR.

Para lo cual se utilizard un equipo suministrado por la Universidad Israel es un MegiQ
VNAO0460, que como se ha mencionado es un equipo que dispone de la capacidad de analizar
redes vectoriales de radio frecuencia, este equipo se utiliza en proyectos de alta frecuencia y al

tener la antena una frecuencia central de 3.5 GHz es perfecto para el analisis.

Figura 4.25 MegiQ VNA-0460

Fuente: www.batronix.com (2020)

Caracteristicas principales del VNA-0460

El VNA-0460 es un analizador de red vectorial bidireccional de 2 puertos que se controla
desde una PC a través de una conexion USB.
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El software incluido proporciona un control total sobre las mediciones, la configuracion,

el almacenamiento de datos y los informes.

Este VNA es ideal para medir todo tipo de microcircuitos como antenas, atenuadores,
amplificadores, etc. Las bandas de telecomunicaciones en las que trabaja son GSM, Wifi,
DECT, GPS, DECT, ISM, Bluetooth, Zigbee. (www.megig.com, 2020)

Entre las caracteristicas principales del VNA-0460 estan:

¢ VNA bidireccional de 2 puertos

e Medida S11, S12, S21, S22

e Frecuencia 400 MHz a 4 GHz

e Potencia -30 a + 5dBm

¢ Barrido de hasta 20001 puntos

¢ Velocidad de barrido de hasta 4000 muestras por segundo

e Normalizacion completa de 12 términos

¢ Barridos paramétricos

e Posee asistente de Calkit de calibracion

e Formatos de visualizacion: impedancia de la fuente, impedancia del puerto, pérdida de
retorno, pérdida directa, ROE, impedancia, impedancia (Smith), ganancia, ganancia

polar.

Para realizar las pruebas de campo de la antena se debe tomar un par de precauciones
mencionadas por el fabricante, el primer paso instalar el software que viene incluido en los

elementos que acompanan al VNA.

Otro paso importante antes de caracterizar la antena es calibrar el quipo, para el proyecto
se usara el puerto 1 del VNA vy para calibrarlo sera necesario un kit de calibracion también

incluido junto al VNA.

Una vez cumplido con estos parametros que son necesarios para el correcto analisis de la

antena, ya se pueden realizar las pruebas respectivas.
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4.5.2 Andlisis de resultado

En cuanto a los resultados obtenidos en las simulaciones se debe entender en primer lugar
que, los parametros a los que se pretende llegar despues de la realizacion del proyecto, son los
establecidos por la FCC (Federal Communications Commission), que establece el ancho de banda
para las antenas > 500 MHz a -10 dB dentro del rango de la UWB 3.1 GHz a 10.6.

Una vez realizadas simulaciones finales del proyecto, se pudo obtener los siguientes
parametros que seran analizados a continuacion, en cuanto a el parametro S, se puede mencionar
que a -10 dB su ancho de banda es aproximadamente de 700 MHz, se encuentra que la magnitud
para la frecuencia de 3.5 GHz es -16 dB, con estos datos se puede al menos confirmar que la
antena esta irradiando, puesto que si rebasa -10 dB y esta sobre los — 15dB se considera el rango

aceptable para la antena a la frecuencia de resonancia
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Figura 4.26. Parametro S11 obtenido de la simulacion con las especificaciones mencionadas

Fuente: realizado por el autor en COMSOL

Después de realizar las calibraciones pertinentes en el equipo VNA-0460, se pudo obtener

los siguientes datos de la antena implementada, datos que se detallan a continuacion.

En la figura 4.27 se pueden observar dos picos de resonancia que sobrepasan el limite de
-10 dB cuyas frecuencias son 2.4 GHz a -10,8 dB y la que interesa para el estudio 3,480 GHz a

-13dB. Estas mediciones corresponden a las pérdidas de retorno (return loss), que muestra
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cuanto de la onda de voltaje esta de regreso, para entenderlo mejor, si el valor de la magnitud se
acerca a 0 dB quiere decir que toda la onda de voltaje esta de regreso lo que causa que la antena
no irradie potencia alguna en ese rango de frecuencia, no asi, con las mediciones que sobrepasan
el limite de -10 dB, la teoria dice que los picos que se ven en la grafica obtenida del VNA deben
al menos llegar al limite de -10 dB para considerarse frecuencia radiante.

B« [ -]«]

4 AR

Figura 4.27 Pérdidas de retorno antena implementada

Fuente: Elaborada por el autor

Con el fin de validar los datos se realizara el calculo de errores para comparar los datos

obtenidos en las simulaciones como en las pruebas con el VNA.

Para hacerlo se calculara el error porcentual que es la forma en la que se evalla que tan
inexacta es una medicidn con respecto al valor estandar o propuesto para un estudio, se lo calcula
tomando el valor real menos el valor medido, dividido para el valor real y multiplicado por el
100%, en términos generales el error porcentual es la diferencia que existe entre el valor real y

el medido expresado en funcion del 100 %.

Tabla 4.8 Célculo de error porcentual

Simulacién Medicion VNA
Frecuencia de operacion 3.5 GHz 3.5 GHz
Frecuencia obtenida 3.5 GHz 3.480 GHz
Error (%0) 0 % 0.571 %

Fuente: Elaborado por el autor
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Otro factor a considerar en la comparacién de la antena desarrollada sera el VSWR que se
obtuvo de la simulacion, en la figura 4.28 se puede apreciar una medicion de 1.4 para la
frecuencia de 3.5 GHz que es la que interesa para el estudio, adicionalmente se puede mirar que
hay otro VSWR bajo para la frecuencia de 4.5 GHz.

Global: Voltage standing wave ratio (1)
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Figura 4.28. VSWR de la antena simulada

Fuente: Realizado por el autor en COMSOL

Una vez revisados los datos obtenidos de las simulaciones se puede avanzar a el analisis

de los datos obtenidos de la caracterizacion de la antena por medio del VNA.

Figura 4.29 VSWR de la antena implementada

Fuente: realizado por el autor
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Usualmente cuando se realiza andlisis de parametros para una antena esta presente el
VSWR, también conocido como ROE (relacion de onda estacionaria), que no es otra cosa mas
que la relacion que existe entre la cantidad de energia irradiada por la antena y la cantidad de

energia reflejada por diferentes factores como pueden ser acoples, cables, plano a tierra, etc.

En la siguiente tabla 4.9 se pude observar la relacion que existe la ROE y la potencia
reflejada en porcentaje.

Tabla 4.9 Calculo de coeficiente de reflexion y potencia reflejada

VSWR (ROE) | Coeficiente de Potencia reflejada
reflexion (en porcentaje al 100
%)
Ecuaciones para el calculo .l rl= YoWR—1 \r|2
P I = Vswr+1
Antena Simulada 1.4 0.17 2.718%
Antena implementada 1.52 0.2 4.25 %

Fuente: Realizada por el autor

En funcién del VSWR (ROE) obtenido tanto en la simulacion como en la medicion con el
VNA, se puede obtener el coeficiente de reflexion para calcular la potencia reflejada de la antena
en este caso para la simulacion estd en 2.78 % de potencia reflejada, mientras que en la antena
implementada la potencia reflejada estd en 4.25 %, lo que indica que las antenas se encuentran

en los rangos aceptables de radiacion, puesto que la potencia reflejada es relativamente baja.

Para tener una idea mas clara de la relacién que existe entre el VSWR (ROE), se puede ver
la tabla 4.10 que muestra las diferentes potencias reflejadas en funcion del VSWR que se haya

medido u obtenido en simulaciones.
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Tabla 4.10 Valores tipicos calculados entre VSWR y potencia reflejada

VSWR Voltaje reflejado Potencia reflejada (%0)
1.0:1 0 0
1.1:1 5 0.22
1.2:1 9 0.82
1.3:1 13 1.70
14:1 17 2.8
1.5:1 20 4
1.6:1 23 5.3
1.7:1 26 6.7
1.8:1 29 8.2
1.9:1 31 9.6
2.0:1 33 11.11
2.5:1 43 18.4
3.0:1 50 25
4.0:1 56 36
5.0:1 67 44.4
10.0:1 82 67

Fuente: Realizada por el autor

En cuanto a los valores de la carta de Smith de visualizan en la figura 4.30, la carta de
Smith es una forma de observar impedancias, admitancias, coeficiente de reflexion, parametros
de dispersion en un solo grafico que expresa las impedancias en el plano complejo para verificar

el nivel de adatacion de una antenas, lineas de transmision, etc.

Mientras mas se acerca la grafica a los valores la impedancia normalizada de 50 ohms que
se sitda en el centro de la carta des Smith, se dice que la antena estd bien adaptada, caso
contrario, si se aleja del centro de la carta de Smith implicaria peor adaptacion lo que repercutiria

en el desemperio de la antena.
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Bl

< NERD

Figura 4.30 Carta de Smith impedancia de antena implementada

Fuente: Realizada por el autor

En la figura 4.30 obtenida de las mediciones del VNA se puede observar que los valores
de resonancia para la antena no pasan por el centro, pero se encuentran bastante cerca de la
impedancia en el centro de la carta de Smith puesto que la impedancia para 3.5 GHz se mide en

49.87-j21.32, datos con los que se puede decir que cumple con criterios de funcionalidad.

Con los resultados obtenidos tanto en la simulacion como en la implementacion se
observa que cumplen con las frecuencias de resonancia para las que fueron disefiadas las
antenas, cabe anotar que, con algunas pequefias diferencias entre la implementacion y la
simulacion, diferencias que eran de esperarse al ser implementada la antena de manera artesanal,
y en cuanto a las frecuencias resonantes no deseadas que aparecen en los resultados podrian
suprimirse con filtros notch, que son ranuras que se hacen en el metalizado de la antena para

eliminar rangos de frecuencias especificos, acotacion que podria servir para estudios futuros.
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CONCLUSIONES

La antena vivaldi de ranura cénica que es objeto de este estudio, es en efecto una antena
que posee un gran ancho de banda, ademas de gran directividad y su costo de produccion
en relativamente bajo, lo que la hace especialmente deseable a la hora de implementarla
en proyectos de este tipo. Para su elaboracion fue necesario un sustrato FR4 con una

constante dieléctrica de 4,4, grosor de 1,524 mm 0.2 perdidas tangenciales.

El disefio tedrico de la antena se utilizaron las ecuaciones disponibles en la literatura
existe para lo cual se ha consultado con el mayor rigor la mejor forma de obtener los
mejores y mas eficaces parametros para consolidar el éxito en la simulacion de

parametros en el software escogido para este fin.

La simulacion y optimizacion de parametros de la antena vivaldi en el software
COMSOL se observa la variacion de pardmetros y su incidencia a la hora de modificarlos
en el disefio para obtener los resultados deseados y escoger el mejor, para la
implementacion, por lo cual se optd por el uso de varios tipos de sustratos que estan

especificados en el estudio y optimizar el que mejores resultados ofrece.

Como ya se ha mencionado con anterioridad para la implementacion de las antenas se
utilizé con un sustrato FR4, cuya constante dieléctrica es 4,4, su grosor es de 1.524 mm,
provee los pardmetros deseados para el éxito del estudio los cuales se comportan tal
como es esperado, brindando un ancho de banda aceptable a -10 dB, resuena a 3,4 GHz

y funciona a -13 dB, estos son los datos recogidos de la misma.

Al realizar una comparacion de datos obtenidos con las simulaciones y las obtenidas con
el VNA se desprenden algunas observaciones interesante, como la variaciones que hubo

en cuanto a pardmetros entre la simulacion y la implementacion, variaciones que pueden
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deberse a la calidad de los materiales o la técnica utilizada para la implementacion de la
antena de cualquier forma se cumplio con los parametros promedio para su

funcionamiento.

Como conclusion final las antenas vivaldi en general son antenas muy prometedoras
para desarrollar tecnologias a futuro, como por ejemplo para transmisiones de video de
alta resolucion, aprovechando su gran ancho de banda, también podria crearse
conexiones entre dispositivos cercanos como serian un reproductor de video, audio y un
TV o reproductor de sonido, todas las caracteristicas de la antena vivaldi se prestan para

este avance en tecnologia.
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RECOMENDACIONES

Para la fase de simulacidn es necesario escoger de manera adecuada el simulador de
onda completa, debe ser uno que se ajuste a nuestra necesidad ya que de este apartado
se desprenderan los parametros 6ptimos que se utilizaran posteriormente en la
implementacion del mismo. EI software COMSOL ademas de ser versatil a la hora de
ingresar los datos para la simulacién en una potente herramienta para optimizar los

diferentes proyectos de radio frecuencia.

Para el grabado es importante tener en cuenta que un acido como el cloruro férrico es
bastante corrosivo y se debe ser cuidadoso al momento de utilizarlo para no tener
problemas posteriores en la antena que se necesita implementar ya que errores en el

grabado pueden ser bastante perjudiciales a la hora de obtener los resultados finales.

Los materiales a utilizar son de vital importancia al momento de desarrollar proyectos
con antenas, razon por la que siempre se debe verificar la calidad de los mismos, y con
esto se garantiza el éxito del proyecto, a pesar de ser una desventaja el no tener gran

variedad de sustratos en el mercado.

Se debe calibrar bien el equipo VNA para obtener las mejores mediciones y evitar errores

en las mismas.
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Introduction

Read this book if you are new to COMSOL Multiphysics®. It provides an
overview of the COMSOL® environment with examples that show you how to use
the COMSOL Desktop® user interface and the Model Builder. It also provides a
quick introduction to creating applications using the Application Builder.

If you have not yet installed the software, install it now according to the
instructions at www.comsol.com /product-download.

In addition to this book, an extensive documentation set is available after
installation. Tutorials can be found throughout the COMSOL website, including
in the Video Gallery at www.comsol.com/videos and on the COMSOL Blog at
www.comsol.com/blogs.
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COMSOL Desktop®

QUICK ACCESS TOOLBAR — Use these
buttons for access to functionality such as file
open/save, undo/redo, copy/paste, and delete.

APPLICATION BUILDER —

RIBBON — The ribbon tabs have buttons
and drop-down lists for controlling all
steps of the modeling process.

Click this button to switch to
the Application Builder and
start building an application
based on your model.

MODEL BUILDER
TOOLBAR

MODEL TREE — The model —
tree gives an overview of
the model and all of the

functonality and operations
needed for building and solving

associated toolbar buttons
gives you an overview of the
model. The modeling process
can be controlled from
context-sensitive menus

6|

S  DEHB>YcERE] ANE-
n Home  Defintions  Geometry  Materiale  Physic Mesh  Study  Results  Dedeloper
o - Vanables ~ [t Import
& Bj & L ) A
A li 7 06 Functions - = eaLivelink - bl o = S0
I Application Component Add Parameters Build Add Hest Transfer  Add Build  Mesh
Builder 1 Component + . All Material inSclids »+  Physics Mesh 1+
phcs Mode! T Matene: Physics Aest
Mode! Builder A G CS
- T ¥ Qe @ v iz m
4 2 Untitled.mph (roat) @ Build Al
4 & Global Definitions
2 Parameters1 Labek:  Geometry 1 =)
12 Materials v
4 T Component1 fcamp?) a0k
v E& Definitions [ Sealevalues when changing units
b A Geometry 1
I — 152 Matenals Lenhiiut
« | Heat Transfer in Solids (bt} o X
= Solid 1 Angular unit
B Initial Values 1 T Z
T Themnal Insulation 1 o
A Mesh1 v Advanced
4~ Study 1
[77 Step 1: Stationary Geometry representation:
b 4% Results CAD kermel X
Default repair tolerance
Automatic v
v Automatic rebuile
MODEL BUILDER — SETTINGS WINDOW —
z
The Model Builder window  Click any node in the model Wl o
with its model treeandthe  tree to see its associated

Settings window displayed next
to the Model Builder.

Messages Progress Log Table

S

Compute

@
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GRAPHICS WINDOW TOOLBAR

Untitiedmph - COMSOL Multiphysics

~do "R — B
o R W | B B
Seudy  Add Add Plat Windows Reset
T+ Study Group * *  Deskiop+
BBy EYE x5 @03

GRAPHICS WINDOW — The Graphics window presents
interactive graphics for the Geometry, Mesh, and Results nodes.
Operations include rotating, panning, zooming, and selecting.

INFORMATION WINDOWS — The Information windows will display vital
model information during the simulation, such as the solution time, solution

progress, mesh statistics, solver logs, and, when available, results tables.

242GB|339GB
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The screenshot on the previous pages is what you will see when you first start
modeling in COMSOL Multiphysics using the Model Builder. The COMSOL
Desktop™ user interface provides a complete and integrated environment for
physics modeling and simulation as well as application design, providing you with
the tools necessary to build a user-friendly interface for your models. You can
customize the desktop to your own needs. The windows can be resized, moved,
docked, and detached. Any changes you make to the layout will be saved when
you close the session and available again the next time you open COMSOL
Multiphysics. As you build your model, additional windows and widgets will be
added. (See page 26 for an example of a more developed desktop.) Among the
available windows and user interface components are the following:

Quick Access Toolbar

The Quick Access Toolbar gives access to functionality such as Open, Save, Undo,
Redo, Copy, Paste, and Delete. You can customize its content from the Customize
Quick Access Toolbar list (the downward-facing arrow to the right of the toolbar).

Ribbon

The ribbon at the top of the desktop gives access to commands used to complete
most modeling tasks. The ribbon is only available in the Windows® version of the
COMSOL Desktop environment and is replaced by menus and toolbars in the
0S X and Linux® versions. Click the Application Builder button to switch from the
Model Builder to the Application Builder and start building an application based
on your model.

Settings Window

This is the main window for entering all of the specifications of the model,
including the dimensions of the geometry, properties of the materials, boundary
conditions and initial conditions, and any other information that the solver will

8|
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need to carry out the simulation. The picture below shows the Settings window for

the Geometry node.

Model B

4 & Untitled.mph (root)
4 () Global Definitions
Pi Parameters 1
izs Materials
4 [ Component 1 (comp1)
b = Definitions
b YA Geometry 1
izs Materials
4 |[@ Heat Transfer in Solids (ht)
= Solid 1
i Initial Values 1
% Thermal Insulation 1
A\ Mesh 1
4 ~db Study 1
|7 Step 1: Stationary

b @ Results

Plot Windows

v 2 Settings
Geometry
2 Build All
Label: Geometry 1
¥ Units

[] Scale values when changing units
Length unit:

m

;
il|

Angular unit:

_ Degrees

v Advanced

Geometry representation:
LCAD kervel

-

Default repair tolerance:

Automatic
Automatic rebuild

These are the windows for graphical output. In addition to the Graphies window,
Plot windows are used for visualizing results. Several Plot windows can be used to

show multiple results simultancously. A special case is the Convergence Plot
window, an automatically generated Plot window that displays a graphical

indication of the convergence of the solution process while a model is running.

Information Windows

These are the windows for nongraphical information. They include:
* Messages: Various information about the current COMSOL Multiphysics

session is displayed in this window.

* Progress: Progress information from the solver in addition to stop buttons.

¢ Log: Information from the solver, such as the number of degrees of freedom,
solution time, and solver iteration data.

e Table: Numerical data in table format as defined in the Results node.

» External Process: Provides a control panel for cluster, cloud, and batch jobs.
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Other Windows

The Windows drop-down list in the Home tab of the ribbon gives you access to all
COMSOL Desktop windows. On OS X and Linux®, you will find this in the
Windows menu. In addition to the windows described earlier you can access the
following windows:

* Add Physics and Add Multiphysics: Expand the physics interfaces in a model.
* Add Study: Change the type of study.

+ Add Material from Library and the Material Browser: Access the material
property libraries.

* Application Libraries: Choose among the collections of MPH-files containing
tutorial models and runnable applications with accompanying documentation.

* Part Libraries: Load one of the predefined parameterized geometry models.

* Selection List: Show a list of geometry objects, domains, boundaries, edges,
and points that are currently available for selection.

* Properties: View model tree node properties.

» Debug Log: Display debug information for methods.

* Recovery Files: View recovery files.

» Comparison Results: Compare the Model Builder and Application Builder
settings of two MPH files.

Progress Bar with Cancel Button

The Progress Bar with a button for canceling the current computation, if any, is
located in the lower right-hand corner of the COMSOL Desktop intertface.

Dynamic Help

The Help window provides context-dependent help texts about windows and
model tree nodes. If you have the Help window open in your desktop (by typing
F1, for example), you will get dynamic help (in English only) when you click a
node or a window. From the Help window, you can search for other topics, such
as menu items.

The Model Builder and the Application Builder

The two main components of the COMSOL Desktop environment are the Model
Builder and the Application Builder.

The Model Builder is the tool where you define the model and its components,
such as how to solve it, the analysis of results, and creating reports. You do that by

10|
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building a model tree. The model tree reflects the underlying data structure, the
model object, which stores the state of the model including settings for geometry,
mesh, physics, boundary conditions, studies, solvers, postprocessing, and
visualizations.

The Application Builder allows you to quickly create an application with a
specialized user interface that is easy to use. An application is typically based on a
model created with the Model Builder. The Application Builder provides two
important tools for creating applications: The Form editor and the Method editor.
In addition, an application can have a menu bar or a ribbon. The Form editor
includes drag-and-drop capabilities to easily access and include user interface
components, such as input fields, graphics windows, and buttons. The Method
editor is a programming environment that, for example, allows you to modify the
model represented by the model object data structure. You can also use the
Method editor to add user interface logic and auxiliary functionality to an
application. The Java® programming language is used to write code in the Method
editor, which means that all Iava® syntax and ]ava® libraries can be used.

In the Method editor, program code is stored in methods. A method is another
name for what is known in other programming languages as a subroutine,
function, or procedure. Methods can be used to modify the model object data
structure in the Model Builder and the Application Builder. A method can be used
both for modifying the model object of the current session and for modifying the
model object in a running application.

This book, Introduction to COMSOL Multiphysics, gives a detailed introduction
to using the Model Builder and a quick introduction to the Application Builder.
For detailed information on how to use the Application Builder, including the
Form editor and Method editor, see Introduction to Application Builder.

Applications, COMSOL Server, and COMSOL Compiler

The Application Builder is included in the Windows® version of COMSOL
Multiphysics. With a COMSOL Multiphysics license, applications can be run from
the COMSOL Desktop environment. Although applications cannot be built with
the macOS or Linux® versions of the software, applications can still be run with
COMSOL Multiphysics on those platforms.

With a COMSOL Server™ license, applications can be run in major web browsers
on a variety of operating systems and hardware platforms. In addition, you can run
applications by connecting to COMSOL Server with an easy-to-install COMSOL
Client for Windows®.
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The COMSOL Client for Windows® allows a user to run applications that require
a LiveLink™ product for CAD (this functionality is not available when running
applications with a web browser).

Running applications in a web browser does not require any installation and no
web browser plug-ins are needed. Running an application in a web browser
supports interactive graphics in 1D, 2D, and 3D. In a web browser, graphics
rendering in 3D are based on WebGL™ technology, which comes included with
all major web browsers.

To create an application based on your model, click .

. . . y . Home Definitions Geom
the Application Builder button, accessible from the :
Home tab in the ribbon. A S| %

A - Applicati Al
By using the COMSOL Compiler product you can PN | e i

compile your application (MPH-file) to an
executable file for Windows®, Linux®, and
macOS. You can freely distribute the executable
and it can be run without any license file.

For more information on creating COMSOL applications, refer to the section
“Building an Application with the Application Builder” on page 96 and the book
Introduction to Application Builder.
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Preferences

Preferences are settings that affect the modeling environment. Most are persistent
between modeling sessions, but some are saved with the model. You access the
preferences from the File menu by selecting Preferences.

3 Preferences =
Add-in Libraries Visualzation
Application Builder Rendering: | OpenGL g
Agplication Libraries T
Opti for | Qual A
Client Server ptimize for. | ty
Email Antialiegsing: | Medium
Faes Detail [ "Normal =
Forms
Genenal Colortheme: | Defoukt  ~|

Geometry W Show logo on canvas
\phi: "] Wi Show mouse coordinates when drawing
Graphics Tooloars Display format (masimum number of digits)
Heg Graph: 5
LiveLink Connections N T
Methods Wraxes:
Model Builder 3D mxes: 3
Multicore and Cluster Computing  Color legend: 3

Parametric Sweep Wit

Far! jbwdies Use softy dering for im ort
e vare render e
Physics Builder SOIWarE rendening [DKImAge Cp
Quick Access Toolbar Rotabion center
Remote Computing Wi Aute
Results ! Setwith mouse middle-click
Security Vicibility: | Alwayshide v
Show Mere Options Msose
Updat=s S )
/1 3Dconneion space mouse
Selections
| Reguire click in Graghics window to activate hovering
Fonts
/| Load syst=m fonts
Default font
Family: | Vera -
Size: | Defauitsize v | pt
| Factory Settingsforall || Import... Export...

In the Preferences window, you can change settings such as graphics rendering, the
number of displayed digits for results, the maximum number of CPU cores used
for computations, or paths to user-defined application libraries. Take a moment to
browse your current settings to familiarize yourself with the different options.

There are three graphics rendering options available: OpenGL®, DirectX®, and
Software Rendering. The DirectX® option is not available in macOS or Linux®, but
is available in Windows® if you choose to install the DirectX® runtime libraries
during installation. If your computer does not have a dedicated graphics card, you
may have to switch to Software Rendering for slower but fully functional graphics.
A list of reccommended graphics cards can be found at:

Wwww.comsol.com /system-requirements
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Creating a New Model

You can set up a model guided by the Model Wizard or start from a Blank Model as
shown in the figure below.

®  DEEB>SCEHGB

Home Definitions Geometry
New

.mph
Model
Wizard

“mph
Blank Model

CREATING A MODEL GUIDED BY THE MODEL WIZARD

The Model Wizard will guide you in setting up the space dimension, physics, and
study type in a few steps:

I Start by selecting the space dimension for your model component: 3D, 2D
Axisymmetric, 2D, 1D Axisymmetric, or 0D.

O NBEHEP» R

Home Definitions Geometry Materials Physics Mesh Study

Select Space Dimension

(=== =~
[ 1 ? i
2D 1D
22 Axisymmetric 2D Axisymmetric [

2 Now, add one or more physics interfaces. These are organized in a number of
physics branches in order to make them easy to locate. These branches do not
directly correspond to products. When products are added to your COMSOL
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Multiphysics installation, one or more branches will be populated with
additional physics interfaces.

® DR > OEDE

Home Definitions Geometry Meterials Physics Mesh Study Results Developer

Select Physics Review Physics Interface

| Search | Heat Transfer in Solids (ht)

v

() Recently Used
X ACDC
M) Acoustics Temperature: T
:','_3 Chemical Species Transport
1 |l Electrochemistry
= Fluid Flow
(! Heat Trensfer
|18 Heat Transfer in Solids (ht)
1= Heat Tiansfer in Fluids (ht)
| Heat Transferin Solids and Fluids (ht)
> i Conjugate Heat Transfer
%" Radiation
| Electromagnetic Heating
1 Lumped Thermel System (Its)
\U Thin Structures
» 74 Heat and Moisture Transport
88 Heat Transfer in Porous Media [ht)
@ Local Thermal Nonequilibrium
- | Metal Processing
| Bicheat Transfer (ht)
S Heat Transfer in Pipes (htp)
ﬁ Thermoelecine Effect
» it Optics

Dependent Variables

I

AV Vv

Add |
Added physics interfaces:
|8 Heat Trensfer in Solids (ht)

| Remove _|

e Space Dimension e Study
Help e Cancel E'/Done
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3 Select the Study type that represents the solver or set of solvers that will be used
for the computation.

Home Definitions Geometry Materials Physics

Select Study

4~ General Studies
[= Stationary
[¥L Time Dependent

4~ Preset Studies for Selected Physics Interfaces
[, Thermal Perturbation, Eigenfrequency
E Thermal Perturbation, Frequency Domain

b~ Mere Studies

~dv Empty Study

Added study:
[~ Stationary

Added physics interfaces:
(@ Heat Transfer in Solids (ht)

° Physics
Help 6 Cancel E‘/Done

Finally, click Done. The desktop is now displayed with the model tree configured
according to the choices you made in the Model Wizard.

CREATING A BLANK MODEL
The Blank Model option will open the COMSOL Desktop interface without any

Component or Study. You can right-click the model tree to add a Component of a
certain space dimension, physics interface, or Study.
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The Ribbon and Quick Access Toolbar

The ribbon tabs in the COMSOL Desktop environment reflect the modeling
workflow and give an overview of the functionality available for each modeling
step, including building simulation applications from your models.

Rl Home  Defintions  Geometry  Materials  Physics  Mesh  Study  Result Developer  Temperature ()

2 y & Variables - 1= Import ™ o0 A — R e J
A 'i Fj B ® =y .*. e n A2 = RN 1 ﬁ fi, |
Application | Component  Add Parameters Build Add Electric  Add Buld Mesh  Compute Study Add | Tempersture AddPlot  Windows Reset
Builder T+ Component» . T+ Study [ht] «

Al Metesial | Currents v Physics Mesh 1v Group * . Desktop ~

The Home tab contains buttons for the most common operations for making
changes to a model, running simulations, and for building and testing
applications. Examples include changing model parameters for a parameterized
geometry, reviewing material properties and physics, building the mesh, running
a study, and visualizing the simulation results.

There are standard tabs for each of the main steps in the modeling process. These
are ordered from left to right according to the workflow: Definitions, Geometry,
Materials, Physics, Mesh, Study, Results, and Developer.

Contextual tabs are shown only if and when they are needed, such as the 3D Plot
Group tab, which is shown when the corresponding plot group is added or when
the node is selected in the model tree.

Geametry  Matesiak Meh  Sudy  Readts  Developer

Line

Line. &) Annctation ‘ ) Evaluste Along Nommal| -] CutLine Direction ) Second Point for Cut Plane Nermal wn
O

: Particle Tajectories boe, / FinstPaint forCutbine yy Cut Line Surtace Norma! %) Cut Plane Noana!

™ Sutace 5 Aniow Suface 1= Soeamiine (&) Mesh Plots - * Second Foint for Cut Line 15 First Peint for Cut Plane Nomal 4 Cut Plane Noana! fram Suface

ow Yolume T Isosurtace ¥ Contour
Image Saimetion

Modal tabs are used for very specific operations, when other operations in the
ribbon may become temporarily irrelevant. An example is the Work Plane modal
tab. When working with work planes, other tabs are not shown, since they do not
present relevant operations.

B v | o | i o

I Impart @ Circle || Square ) EP] . 7| Chamfer {j Delete A = @B — =

® £ : (pt 7 ® 2 . B = a = T | O
FInsert Sequence @ Elipse  /TPolygon e 71 Fillet 3 X

Build i Sketch More Boolesns snd  Transforms Conversions 2 Parts Programming Selections Colors Messure Delete Close

Al [I= Export CIRectangle = Pomt  Pripnitives « Partitions ~ - . » Tangent ¥ Cross Section - - - . Sequence

THE RIBBON VS. THE MODEL BUILDER

The ribbon gives quick access to available commands and complements the model
tree in the Model Builder window. Most of the functionality accessed from the
ribbon is also accessible from contextual menus by right-clicking nodes in the
model tree. Certain operations are only available from the ribbon, such as selecting
which desktop window to display. In the COMSOL Desktop interface for macOS
and Linux®, this functionality is available from toolbars, which replace the ribbon
on these platforms. There are also operations that are only available from the
model tree, such as reordering and disabling nodes.
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THE QUICK ACCESS TOOLBAR

The Quick Access Toolbar contains a set of commands that are independent of the
ribbon tab that is currently displayed. You can customize the Quick Access Toolbar
and add most commands available in the File menu, including commands for
undoing and redoing recent actions, as well as for copying, pasting, duplicating,
and deleting nodes in the model tree. You can also choose to position the Quick
Access Toolbar above or below the ribbon.

MACOS AND LINUX®

In the COMSOL Desktop environment for macOS and Linux®, the ribbon is
replaced by a set of menus and toolbars.

Flo Edt Wediws Ogtions Tacks Help
TRe W s ma noe - RE e i HestTarferinSodds - W W @ Meshl - iyl - &

¥ Defiitiors A Oeometyy. G Matorials @ Phwacs & Nesh o Shudy |1 Resuls
The instructions in this book are based on the Windows® version of the COMSOL
Desktop environment. However, running COMSOL Multiphysics and the
COMSOL Desktop environment in macOS and Linux®is very similar, keeping in
mind that the ribbon user interface components can instead be found in the
corresponding menus and toolbars.

The Model Builder and the Model Tree

Using the Model Builder, you build a model by starting with the default model
tree, adding nodes, and editing the node settings.

All of the nodes in the default model tree are top-level parent nodes. You can
right-click on them to see a list of child nodes, or subnodes, that you can add
beneath them. This is the means by which nodes are added to the tree.

When you click on a child node, you will see its node settings in the Settings
window. It is here that you can edit node settings.

It is worth noting that if you have the Help window open, which is achieved either
by selecting Help from the File menu or by pressing the function key F1, then you
will also get dynamic help (in English only) when you click on a node.
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THE ROOT, GLOBAL DEFINITIONS, AND RESULTS NODES

A model tree always has a root node (initially

labeled Untitled.mph), a Global Definitions node, Model Builder

and a Results node. The label on the root node is v =

X .. 2% 4 % Untitled.mph {root)
the name of the multiphysics model file, or MPH T

file, to which the model is saved. The root node b @ Component 1 (comp1)
has settings for author name, default unit system, i g ;t”“i‘
g esults

and more.

The Global Definitions node has a Parameters and

Materials subnode by default. The Global Definitions node is where you, among
other things, define parameters, variables, functions, and couplings that can be
used throughout the model tree. They can be used, for example, to define the
values and functional dependencies of material properties, forces, geometry, and
other relevant features. The Global Definitions node itself has no settings, but its
child nodes have plenty of them. The Materials subnode stores material properties
that can be referenced in the Component nodes of a model.

The Results node is where you access the solution after performing a simulation
and where you find tools for processing the data. The Results node initially has five
subnodes:

» Datasets, which contains a list of solutions

. Madel Ruilder =3
you can work with. Model Builde '
e : o3 - S ErElE v

. Den‘ved Ydues, which c.lchncsl values to be ) 4 2 Untitied.mph (root)
derived from the solution using a number of b () Global Definitions
postprocessing tools. b W Component ] {comp')

b~ Study 1

» Tables, which is a convenient destination for 4 (B Results
the Derived Values or for Results generated by HH Datasers

. A ) L ea: Derived Values
probes that monitor the solution in B Tables
real-time while the simulation is running. @ Export

55 Reports

 Export, which defines numerical data,
images, and animations to be exported to
files.

* Reports, which contains automatically generated or custom reports about the
model in HTML or Microsoft® Word format.

To these five default subnodes, you may also add more Plot Group subnodes that
define graphs to be displayed in the Graphics window or in Plet windows. Some of
these may be created automatically, depending on the type of simulations you are
performing, but you may include additional figures by right-clicking on the Results
node and choosing from the list of plot types.
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THE COMPONENT AND STUDY NODES

In addition to the three nodes just described,
there are two additional top-level node types:
Component nodes and Study nodes. These are

Mode

-

4 % Untitled.mph ({root)

usually created by the Model Wizard when you b () Global Definitions

create a new model. After using the Model E :; gtm:;?nenﬂ fere?
. n ~ . p u

Wizard to specify what type of physics you are b @ Results

modeling and what type of Study (for example,

steady-state, time-dependent,

frequency-domain, or eigenfrequency analysis) you will carry out, the Model
Wizard automatically creates one node of each type and shows you their contents.

It is also possible to add
more Component and Study ~ [VIode! Bul
nodes as you develop the =
model. A model can contain

L)‘

er v
EEE -

4 £ Untitled.mph (root)
p Global Definitions

multiple Component and 4 T Component 1 (comp)—
Study nodes and it would be : f\ z“‘"‘g’“s1 i | rdd Physics
2 cs > eometry & : =
confusing if they all had the S5 Materials E | e
same name. Therefore, b | Heat Transfer in Sof = !nsert Physicsfrom Model
- A\ Add Mesh
these types of nodes can be < d'\:efm &
renamed to be descriptive b @ Results e ’
of their individual purposes. q? fony
. 1 Delete — Del
if a model has dmultiplc = | -
. -
omponent NO ‘LS, they can S
be coupled to form a more A
N i = Properties
sophisticated sequence of g e =
: 3 elp —
simulation steps.
Note that each Study node Keyboard Shortcuts —

may carry out a different

type of computation, so

cach one has a separate Compute button =.

To be more specific, suppose that you build a model that simulates a coil assembly
that is made up of two parts, a coil and a coil housing. You can create two
Component nodes, one that models the coil and the other the coil housing. You
can then rename each of the nodes with the name of the object. Similarly, you can
also create two Study nodes, the first simulating the stationary or steady-state
behavior of the assembly, and the second simulating the frequency response. You
can rename these two nodes to be Stationary and Frequency Domain.
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When the model is complete, save it to a file named Coil Assembly.mph. At that
point, the model tree in the Model Builder looks like the figure below.

In this figure, the root node is named Coil
Assembly.mph, indicating the file in which the
model is saved. The Global Definitions node and
the Results node each have their default name.
Additionally, there are two Component nodes
and two Study nodes with the names chosen in
the previous paragraph.

Model Builder bl

= wElBlE Y

4 % Coil_Assembly.mph (root)
3 Global Definitions
> {m Coil (comp1)
> [@ Coil Housing (comp2)
b ~do Stationary
b
b

~d Frequency Domain

@ Results

PARAMETERS, VARIABLES, AND SCOPE

Global Parameters

Global parameters are user-defined constant scalars that are usable throughout the
model. That is to say, they are “global” in nature. Important uses are:

» Parameterizing geometric dimensions.

» Specifying mesh element sizes.

 Defining parametric sweeps (simulations that are repeated for a variety of
different values of a parameter such as a frequency or load).

A global parameter expression can contain numbers, global parameters, built-in
constants, built-in and user-defined functions with global parameter expressions
as arguments, and unary and binary operators. For a list of available operators, see
“Appendix C — Language Elements and Reserved Names” on page 181. Because
these expressions are evaluated before a simulation begins, global parameters may
not depend on the time variable t. Likewise, they may not depend on spatial
variables like X, y, or z, nor on the dependent variables for which your equations
are solving.

It is important to know that the names of parameters are case sensitive.
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You define global parameters in the Parameters node in the model tree under
Global Definitions.

Model Builder v *  Settings
. - EtIEl~ Parameters
4 @ Coil_Assembly.mph (root)
4 () Global Definitions Label: Parameters 1 =

Py Parameters 1

v
138 Materials Parameters

4 @ Coil (comp1) » ) o
b = Definitions Name Expression Value Description
A\ Geometry 1 L 9[cm] [0.09m Length
55 Materials rad_1 | 6[mm] 0.006 m | Bolt radius
b |@ Heat Transfer in Solids (ht) thb 5(mm] 10,005 m | Thickness
A\ Mesh 1 wbb S[em] [0.05m | Width
b [ Coil Housing (comp2) mh 6[mm] |0.006 m | Maximum element size
b~ Stationary hte 5[W/m*2/K] :5W/(m‘-K) | Heat transfer coefficient
b~ Frequency Domain Vtot | 20[mV] 1002V | Applied voltage
! @ Results

t 1Sy w A=~
Name:
Vtot

Expression:
20[mV]
Description:

Applied voltage

Note that you can add multiple Parameters nodes and they will be named
Parameters |, Parameters 2, ctc. In addition, Parameters can be organized into
several cases and then swept over, for more information see “Parametric Sweeps”
on page 141.

Results Parameters

For greater flexibility, it is possible to define parameters that are only used in the
Results node. Using these parameters does not require resolving the model.

Model Builde v & Settings
- < STE - Parameters
4 @ Coil_Assembly.mph (root)
b € Global Definitions ~ Parameters
b @ Coil (comp1) .
» @ Coil Housing (comp2) Name Expression Value Description
b~ Stationary iso_level 309.5[K] 309.5 K Isosurface level
b~ Frequency Domain
4 {@ Results
Pi Parameters

Datasets
Derived Values

g
B
I
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Result parameters may depend on other parameters and built-in functions.

Variables

Variables have associated Variables nodes in the model tree and can be defined
cither in the Global Definitions node or in the Definitions subnode of any Component
node.

ow]

Model Builder >4

- T v EtE H

4 % Coil_Assembly.mph (root)
4 () Global Definitions
Pi Parameters1
izs Materials
4 [ Componentl (compl)
4 = Definitions
a= Variables1
=/ Boundary System1 (sysi)

14 Viewl

Naturally, the choice of where to define the variable depends on whether you want
itto be global (that is, usable throughout the model tree) or locally defined within
a single Component node. Like a parameter expression, a variable expression may
contain numbers, parameters, built-in constants, and unary and binary operators.
However, it may also contain variables like t, x, y, or z; functions with variable
expressions as arguments; and dependent variables that you are solving for in
addition to their space and time derivatives.

If you have a model with many Variables nodes it may be useful to group them
together by using the Node Group feature, as shown below.

‘®  Show More Options...

E Node Group
= Group by Type

Node groups can be used to group nodes in Global Definitions, Definitions under a
Component, Materials, physics interfaces, and results.

Variables Used in Applications

Model parameters and variables can be used in applications. For example, you can
let the user of an application change the value of a parameter. In addition, variables
to be used in applications can be defined in the Application Builder, in the
application tree under the Declarations node. Such variables can also be used in
model methods.

| 23

89



Scope

The “scope” of a parameter or variable is a statement about where it may be used
in an expression. All global parameters are defined in the Global Definitions node
of the model tree as a Parameters subnode. This means that they are global in
scope and can be used throughout the model tree.

A variable may also be defined in the Global Definitions node, as a Variables
subnode, and have global scope, but they are subject to other limitations. For
example, variables may not be used in Geometry, Mesh, or Study nodes (with the
one exception that a variable may be used in an expression that determines when
the simulation should stop).

A variable thatis instead defined under the Definitions subnode of a Component
node has local scope and is intended for use in that particular Compenent (but,
again, not in the Geometry or Mesh nodes). They may be used, for example, to
specify material properties in the Materials subnode of a Component or to specify
boundary conditions or interactions. It is sometimes valuable to limit the scope of
the variable to only a certain part of the geometry, such as certain boundaries. For
that purpose, provisions are available in the settings for a variable to select whether
to apply the definition either to the entire geometry of the Component or only to
a Domain, Boundary, Edge, or Point.
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The figure at right shows the
definition of two variables, q_pin
and R, for which the scope is limited
to just two boundaries identified by
numbers 15 and 19.

Such a group of numbers is called a
Selection and can be named and
then referenced elsewhere in a
model. This can be useful, for
example, when defining material
properties or boundary conditions
that will use the variable at certain
boundaries but not elsewhere. To
give a name to the Selection, click
the Create Selection button (% ) to
the right of the Selection list.

Although the variables defined in
the Variables node under the
Component > Definitions subnode
are intended to have local scope,
they can still be accessed outside of
the Component node in the model
tree by being sufficiently specific

Label:  Variables1

Gecmetric Entity Selection

Geometric entity level: | Boundary

Selection: Manual

15
19

Active

¥ Variables

»
Name Unt

Expression

2 =D

Descnption

[qpin ] Amu/sqrt(@(L-mu2))[i/m~2] |s/kg  Surface heat source

R sart(c*2+y*2) Im

(=R 2=
Name:
q_pin
Expression;
ATmufsgrtGUL+mu”2NIW/m*2]
Description:

Surfece heet source

Radial distence

about their identity. This is done by using a “dot-notation” where the variable

name is preceded by the name of the Component node in which it is defined and
they are joined by a “dot”. In other words, if a variable named foo is defined in a
Component node named MyModel, then this variable may be accessed outside of the
Component node by using MyModel. foo. This can be useful, for example, when
you want to use the variable to make plots in the Results node. Variables defined
under the Declarations node in the Application Builder are available globally in

form objects and methods but cannot be used in the Model Builder.

The following spread shows an example of a customized desktop with additional

windows.

91

| 25



QUICK ACCESS

TOOLBAR SETTINGS WINDOW RIBBON |
° Ne B> cBHEHT BN
IERE tore | Definibons  Geomelry  Msteriols  Physics  Mesh|  Study  Results  Develaper
L2 p; o Veriebles s 2 Import Ay =
A a & g e | Y |A =
Application Component Add Parameters Bgild Add Turbulent  Add Build Mesh Compute Stu
Builder 1- Component ~ - Yaimneies Cave hI Material | Flow, k-z ~ Physics Mesh T~ 1
pplicatio Model Definitions Geometry Materials Phytics Mes Stu
MODEL BUILDER — =
WINDOW | Model Bt ~ & | Settings Graphics
==t 1= 2 Global Evaluztion QAR by wEEm/ O G-
4 @ shell_and_tube_heat_exchanger.mph (rood) = Evaluate v
4 [ Globel Definitions
Vi Poramerers 1 Label:  Heat Transfer Coefficient
4 Default Model Inputs
Materils il
A/ ‘Componsnt | feorp) Datasets | Study V/Solution 1 (solt) v
b = Definitions
bW Geometiy 1 3 =
b 88 Mabeiiols ~ Expressions +v 5>
3 urbulent Flow, k- sof) » - v =
b {5 Heat Transferin Fluids (1) Bipeession Ut Decatption
b Mutiphysics sveopllabsfritfia., Wimh. |
b A Meshl I
4 ~& Study 1
£ Step 1: Stationary
4 [T, Solver Configurations | (N N =
4 |- solution 1 (sol?) .
MODEL TREE —F— 841 Compile Equations: Stationary Bepiesion
© wae Dependent Vanables 1
. b |7 Stationary Solver 1 Descnption:
4 R Hesults
b & Datasets
b Lo Views ! Data Series Operation
4 1E Derived Values
(&) Heat Transfer Cocfficient
v Inlet Pressure, Water
47 Inlet Pressure, Air
b B Tables
Plot 1
aaq-H EMa -a@
Histogram: Velocity magnitude (m/s) B
x10° I
o\ |
35+ \\ .
3+ 4
2.5 \‘
P .5
- \
3 2 \\
15 \
1l ———— S | Messages Progress Log  Table 4
T = -
. ~ BEREES B vnERE
05 \\\
0 B aveop |(abs(nitf1.quf_u))/(T_water-T_air] (W/(m"2°K))
L
0.5 1 15 33410
Velocity magnitude (mvs)

PLOT WINDOW — The Plot window is used to visualize Results
quantities, probes, and convergence plots. Several Plot windows
can be used to show multiple results simultaneously.
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DYNAMIC HELP — Continuously updated with online access to the
Knowledge Base and Application Gallery. The Help window enables

GRAPHICS WINDOW easy browsing with extended search functionality.
shell_and_tube_heat_ecch mph - COMSOL iphy - m] x
= ~ "R B
Al = 1 R & e,
zh Compute Study Add Velocity, AddPlot = Winfiows Reset
- 1+ Study Streamlines - Group ~ Desktop -
Stud: Result Layout
Help
ce@@Oc-am ~-ad
Streamline: Velocity field @ = search Q
— COMSOL Multiphysics > COMSOL Multiphysics Reference Manual
> Results Analysis and Flots >
350 Derived Values, Evaluaton Groups, and Tables > Global Evaluation
Global Evaluation
340 Lse = Global Evaluation ((£3) ) o define the evalustion of the
numerical value of & global varistle.
« Go to Comman Re: Settings for
information about these sections: Data,
330 Q Expressions, :nd Data Series Operation.
- Table
mm
320
310
300
290
280

.48 GB | 3.52 GB

« Previous Section Next Section »

INFORMATION WINDOWS

PROGRESS BAR WITH CANCEL BUTTON
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Built-In Constants, Variables, and Functions

COMSOL Multiphysics comes with many built-in constants, variables, and
functions. They have reserved names that cannot be redefined by the user. If you
use a reserved name for a user-defined variable, parameter, or function, the text
you enter will turn orange (a warning) or red (an error) and you will get a tooltip
message if you select the text string.

Some important examples are:
+ Mathematical constants such as pi (3.14...) or the imaginary unit i or j

» Physical constants such as g_const (acceleration of gravity), ¢_const (speed
of light), or R_const (universal gas constant)

e The time variable, t

« First- and second-order derivatives of the dependent variables (the solution)
whose names are derived from the spatial coordinate names and dependent
variable names (which are user-defined variables)

» Mathematical functions such as cos, sin, exp, 1log, log10, and sqrt

See “Appendix C — Language Elements and Reserved Names” on page 181 for
more information.

The Application Libraries

The Application Libraries are collections of MPH files containing tutorial models
and runnable applications with accompanying documentation. Tutorial models
show how to use the Model Builder and have documentation that includes
theoretical background and step-by-step instructions. Runnable applications have
instructions on how to use the application. You can readily inspect and edit all
tutorial models and applications to make them your own. Each physics-based
add-on module comes with its own application library with examples specific to its
applications and physics area. You can use the step-by-step instructions and the
MPH files as a template for your own modeling.
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To open the Application Libraries window, sclect Application Libraries [ from the
Windows menu on the Home toolbar or from the File menu . Then, search by
application name or browse under a module folder name.

Application Libraries

C Refresh & Updste COMSOL Application Libraries (7)) Application Gallery
Search

b 3 COMSOL Multiphysics

% AC/DC Module

b )} Acoustics Module

I+ 40 Betteries & Fusl Cells Module

4 CFD Module o

[ Applications

[ Fluid-Structure Interaction

[ High Mach Number Flow

ff Multiphase Flow

Noniscthermal Flow

Particle Tracing This example solves the inc SommtarVaeity Wt

4 [ single-Phase Flow geametry. The

@ backsiep

O hydrocyclone

@ non_newtonisn_flow

© oldroyd_b_ascoslastic

O rotsting disk

O turbulent mixing

@ wster purfication reactor 1

il Thin-Film Flow i
Vesification Famples

mical Reaction Engineering Madule
Composite Materialz Module

I, Corrasion Module HName L
I 9 Design Module Vsed products SO 1 T s sl il g o syl i
I G2 ECAD Imper Madule 7 :
b (L] Flectrachemistry Module Riglsintaces Ll e
b 4§ Electradepasition Module bt AL L TR e,
b @~ Fatigue Madule Created in o
b 3 Geamechanics Module Computation time e
b Heat Transfer Module
b K MEMS Module Author con  From e
b |@ Metal Processing Madule New
b W Microfluidics Module Last modified JubBE 1 1ot W . L Model Wiard
AR e —As il -~ Created [T [ ——
a =g L i e Mael Wisard i, ick 30
Run Application B Open 3 1 the Sebst byt trce. chect Fakd FlowaSinghe Phose Flom>Larsboar Fow (390,
§ Gick aat
53 Open PDF Document 4 Click fady,

Help o Close

Click Open || , Run Application » , or Open PDF Document i=| . Alternatively,
sclect Help > Documentation from the File menu to search by application name or
browse by module. Note that the Run Application option is only available for MPH
files that are runnable applications.

The MPH files in the Application Libraries can have three formats — Solved MPH

files, Compact MPH files, or Preview MPH files:

» Solved MPH files, including all meshes and solutions. In the Application
Libraries window, these appear with the g icon. If the MPH file size
exceeds 25 MB, a tip with the text “Large file” and the file size appears when
you position the cursor at the model’s node in the Application Libraries tree.

» Compact MPH files, with all settings for the model but without built meshes
and solution data to save space in the installation. Some MPH files have no
solutions for other reasons such that the computation time is short and the
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results are easily regenerated. You can open these to study the settings and
to mesh and re-solve. It is also possible to download the full versions — with
meshes and solutions — of most of these when you update your Application
Libraries. These appear in the Application Libraries window with the ¢
icon. If you position the cursor at a compact file in the Application Libraries
window, a No solutions stored message appears. A solved version is available
for download via the Application Library Update (except in a few cases
where the file is a template related to another, regular, model).

» Preview MPH files, with only a model description and thumbnail image
available. These appear in the Application Libraries window with the ¢
icon. The file is a preview of an application or a model file, including the
model description and information about used products and physics
interfaces and the computation time. Solved and compact versions are
available for download. Model documentation will be available if you have
specified the use of online help (see the Reference Manual for details on how
to do this).

The Application Libraries are updated on a regular basis by COMSOL. To check
all available updates, click Update COMSOL Application Libraries [ at the top of the
Application Libraries window. You can also find this option from the File > Help
menu (Windows® users) or from the Help menu (macOS and Linux® users). This
connects you to the COMSOL website, where you can access new applications
and the latest updates.

Application Libraries

C* Refresh rrf,'ﬂ Update COMSOL Application Libraries Application Gallery

| | Search |

b 3 COMSOL Multiphysics

b X AC/DC Module

b)) Acoustics Module

b @ Batteries & Fuel Cells Module
If your computer has an internet connection, then you can click the Application
Gallery button to access a wide range of additional examples from the COMSOL
website.
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Workflow and Sequence of Operations

In the Model Builder window, every step of the modeling process, from defining

global variables to the final report of results, is displayed in the model tree.

Model Builder

-

4 & backstep.mph (root)
4 () Global Definitions
Pi Parameters 1
% Default Model Inputs
ig= Materials
4 @ Component 1 (comp1)
b = Definitions
b YA Geometry 1
b izs Materials
4

Laminar Flow (spf)
& Fluid Properties 1
= Initial Values 1
T Wall1
mw Inlet1
= Symmetry 1
aw Outlet1

A\ Mesh 1
4 ~db Study 1

|7 Step 1: Stationary

b . Solver Configurations

4 ([ Results
Datasets
ea: Derived Values
R Tables
b i Velocity (spf)
b N Pressure (spf)
4 \@ 3D Plot Group 3

4 3£ Streamline 1

@ Color Expression 1

Export
55 Reports

-1

From top to bottom, the model tree defines an orderly sequence of operations.

In the following branches of the model tree, the node order makes a difference
and you can change the sequence of operations by moving the subnodes up or

down the model tree:
* Geometry

¢ Materials

¢ Physics

¢ Mesh

e Study

¢ Plot Groups
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Nodes may be reordered by these methods:

* Drag-and-drop

» Right-clicking the node and selecting Move Up or Move Down
» Pressing Ctrl + Up arrow or Ctrl + Down arrow

In other branches, the ordering of nodes is not significant with respect to the
sequence of operations, but some nodes can be reordered for readability. Child
nodes to Global Definitions is one such example.

You can view the sequence of operations presented as program code statements by
saving the model as a Model File for MATLAB® or as a Model File for java® after having
sclected Compact History in the File menu. Note that the model history keeps a
complete record of the changes you make to a model as you build it. As such, it
includes all of your corrections, including changes to parameters and boundary
conditions and modifications of solver methods. Compacting this history removes
all of the overridden changes and leaves a clean copy of the most recent form of
the model steps. In the Application Builder, you can use the Record Method option
to view and edit program code statements in the Method editor.

As you work with the COMSOL Desktop interface and the Model Builder, you
will grow to appreciate the organized and streamlined approach. However, any
description of a user interface is inadequate until you try it for yourself. In the next
chapters, you are invited to work through two examples to familiarize yourself
with the software.
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Example |: Structural Analysis of a Wrench

This simple example requires none of the add-on products to COMSOL
Multiphysics®. For more fully-featured structural mechanics models, see the
Structural Mechanics Module application library.

At some point in your life, it is likely that you have tightened a bolt using a wrench.
This exercise takes you through a structural mechanics model that analyzes this
basic task from the perspective of the structural integrity of the wrench subjected
to a worst-case loading.

The wrench is, of course, made from steel, a ductile material. If the applied torque
is too high, the tool will be permanently deformed due to the steel’s elastoplastic
behavior when pushed beyond its yield stress level. To analyze whether the wrench
handle is appropriately dimensioned, you will check if the mechanical stress level
is within the yield stress limit.

This tutorial gives a quick introduction to the Model Builder workflow. It starts
with opening the Model Wizard and adding a physics option for solid mechanics.
Then a geometry is imported and steel is selected as the material. You then explore
the other key steps in creating a model by defining a parameter and boundary
condition for the load; selecting geometric entities in the Graphics window;
defining the Mesh and Study; and finally, examining the results numerically and
through visualization.

If you prefer to practice with a more advanced model, read this section to
familiarize yourself with some of the key features, and then go to the tutorial
“Example 2: The Busbar — A Multiphysics Model” on page 59.
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Model Wizard

| To start the software, double-click the COMSOL
Multiphysics icon on the desktop, which will take you to
the New window with two options for creating a new
model: Model Wizard or Blank Model.

If you select Blank Model, you can right-click the root node
in the model tree to manually add a Component and a Study.
For this tutorial, click the Model Wizard button.

If the COMSOL Desktop user interface is already open,

you can start the Model Wizard by selecting New from the
File menu. Choose the Model Wizard.

The Model Wizard will guide you through the first steps of
setting up a model. The next window lets you select the
dimension of the modeling space.

2 In the Select Space Dimension window, select 3D.

| |

o m| |9 T|—
i i
2D 1D

= Axisymmetric | 2t | | Axisymmetric

[
COMSOL
Multiphysics

.mph
Model
Wizard

4

“mph
Blank Model

oD
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3 In Select Physics, sclect
Structural Mechanics > Solid
Mechanics (solid) = . Click Add.

Without add-on modules, Solid
Mechanics is the only physics
interface available in the
Structural Mechanics folder. In
the picture to the right, part of
the Structural Mechanics folder
is shown as it appears when all
add-on modules are available.

Click Study @ to continue.

Select Physics

/| Heat Transfer
[{¢- Optics
&) Plasma
4 Radio Frequency
> #5 Semiconductor
£33 Structural Mechanics
=27 Solid Mechanics (solid)
[ shell shely
&3 Layered Shell [Ishel)
D Membrane (mbm)
.;F: Beam (beam)
1k Truss [truss)
@ Multibody Dynamics imbd)

A v v e

7% Lumped Mechanical System (Ims)

3,33 Rotordynamics
5% Pipe Mechanics [pipem)
¥ Themal Stress

Added physics interfaces:
f27 Solid Mechanics (solid)

Q Space Dimension
Help Q Cancel E‘/Dene

101

[ Search

[ Add |

[ Remove

e Q Study
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4 Click Stationary - under Preset
Studies. Click Done = once you have Select Study

finished.
4 " Generl Studies
Preset studies have solver and i, S e
X X 1448 req_u:n(yDumaln
cquation settings adapted to the lz Sationary 0
% g B % 3 4 Time Dependent
selected Ph\’SlCS, which is, in this 4~ Preset Studis for Selected Physics Interfaces
i g % Bolt Pretension
example, Solid Mechanics. A L Boenfrequency, Prestressed
5 . . . == Frequency Domain, Prestressed
Stationary study is used in this case U, Frequency Domain, Modal
. . 1§ L Buckli
— there are no time-varying loads or A Wt Bt Cider M

[# Random Vibration (PSD)
.. Response Spectrum
[ Time Dependent, Modal

material properties.

Any selection from the Custom b % Mo Studies
Studies branch - requires manual o Sy
. Added study;
Neusl ngS. [= Stationary

Added physics intefaces:
1 Solid Mechanics isclid)

° Physics
Help € Cancel [/ Dene 0

Geometry

This tutorial uses a geometry that was previously created and stored in the
COMSOL native CAD format, .mphbin. To learn how to build your own
geometry, see “Appendix A — Building a Geometry” on page 159.

File Locations

The location of the application library that contains the file used in this exercise
varies based on the software installation and operating system. In Windows®, the
file path will be similar to:

C:\Program Files\COMSOL\COMSOL55\Multiphysics\applications.
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I In the Model Builder window, under Component 1, right-click Geometry |
and select Import =.

4 % Untitled.mph (root)
4 () Global Definitions
Pi Parameters1
iz Materials
4 [ Componentl (compl)

I = Definitions
0 b YA Geometry1 —
222 Materials {58 Build All F8
4 £33 Solid Mechanic = Import
& Linear Elast
o Freel Livelink Interfaces »
= Initial Value 71 Block
A Mesh1

Cone

As an alternative, you can use the ribbon and click Import = from the Geometry
tab.

2 In the Settings window for Import, from the Source list, sclect COMSOL
Multiphysics file.
¥ Import

Source:
| COMSOL Multiphysics file v

Filename:
C:\Program Files\COMSOL\COMSOL55\Multiphysics\i

| Browse... | [ Import |

Include result from virtual operations

.

3 Click Browse and locate the file wrench.mphbin in the application library folder
of the COMSOL installation folder. Its default location in Windows® is

C:\Program Files\COMSOL\COMSOL55\Multiphysics\
applications\COMSOL_Multiphysics\ Structural_Mechanics\wrench.mphbin

Double-click to add or click Open.
4 Click Import to display the geometry in the Graphics window.
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5 Click the wrench geometry in the Graphics window and then experiment with
moving it around. As you point to or click the geometry, it changes color. Click
the Zoom In @ , Zoom Out @, Go to Default 3D View ..., Zoom Extents (3], and
Transparency & buttons on the Graphics window toolbar to see what happens to
the geometry:

- To rotate, click and drag anywhere in the Graphics window.

- To move, right-click and drag.

- To zoom in and out, click the mouse scroll wheel, continue holding it, and
drag.

- To get back to the original position, click the Go to Default 3D View .- button
on the toolbar.

Graphics

aaRr@E Lz ¢y Gy  A-@E@YEF »28 HeclE RS- S-al

Rotate: Click and drag

Pan: Right-click and drag

bl' s x0tm

Also see “Appendix B — Keyboard and Mouse Shortcuts” on page 176 for
additional information.

The imported model has two parts, or domains, corresponding to the bolt and the
wrench. In this exercise, the focus will be on analyzing the stress in the wrench.

38 |

104



Materials

The Materials node « stores the material properties for all physics and all domains
in a Component node. Use the same generic steel material for both the bolt and
tool. Here is how to choose it in the Model Builder.

I Open the Add Materials window.

You can open the Add Materials G 58 Miaterials

window in either of these two 4 5 Solid Mec| 55 Add Material from Library
ways: ':E Linea Browse Materials
¥ mw Freel
- Right-click Component | > & Initial| %% Blank Material
s . : Mesh 1
Materials  in the Model Builder & & D Lyen g
and select Add Material from
Library

- From the ribbon, select the Home tab and then click Add Material.

Add Materia >
2 In the Add Material window, click to (® Add to Global Mateiigls - Add to Component + )
expand the Built-In folder. Scroll down [saseeh |
~ . - iz Nimonic alloy 30
to find Structural steel, right-click, and % Nylon
e 4= Polysilicon
SClCLt Add to component I : {38 Lead Zirconate Titanate [PZT-5H)
3 Examine the Material Contents section i g
in the Settings window for Material to ‘s Solder, 60Sn-40Pb
” l : l " : l Ll iia Steed AISI4340
SCC the propcertics that are avauablc. G 42 Structural steel
Properties with green check marks are i 2 @ Addto Global Materials
used by the physics in the simulation. iz Ty T8 Addto Component |
38 Water, liquid
> ¥} Ac/DC
= Batteries and Fuel Cells
4 Close the Add Material window.
~ Matenial Contents
48 Property Variable Value Unit Property group
[# | Density |rho 7850(kg/m* ... kg/m® Besic
(4 | Young's modulus ,E - 200e9[P2) VPaV Young's modulus and Peisson's ratio
[¥ | Poisson’s ratio nu 0.30 | 1 Young's modulus and Poisson's ratio
| Relative permeability MULiso .. 1 |11 Basic
Heat capacity at constant pressure AT5[)/(kg*K)] |V (kg K) Basic
| Thermal conductivity i, 4450W/ ", |(W/mK)  Basic
Electncal conductivity 4.032¢6[5/m] |S/m Basic
| Relative permittivity | i 1 |1 Basic
| Coefficient of thermal expansion (alphe_iso.. 12.3e-6{1/K] |1/K Basic
Mumaghan third-order elastic meduli | -2.0e11(Pz]  N/m® Murnaghan
Mumaghan third-order elastic moduli m -G.2e11Pe]  N/m’ Murnaghen
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Also see the busbar tutorial sections “Materials” on page 73 and
“Customizing Materials” on page 115 to learn more about working with
materials.

Global Definitions

You will now define a global parameter specifying the load applied to the wrench.

Parameters
| In the Model Builder, under Global Definitions @, choosc Parameters | - .

4 % Untitled.mph (root)
4 () Global Definitions

P; Parameters 1 G

35 Materials
4 |l Component 1 (compT1)

2 Go to the Settings window for Parameters 1. In the Parameters table, enter these
settings:
- In the Name column or field, enter F.

- In the Expression column or field, enter 150 [N]. The square-bracket notation
is used to associate a physical unit to a numerical value; in this case, the unit
of force in Newtons. The Value column is automatically updated based on the
expression entered once you leave the field or press Return.

- In the Description column or ficld,
enter Applied force.

¥ Parameters

" Name Expression Value Description
F |150[N] |150N | Applied force

If you have a Parameters table with more than one entry, you can sort the
table with respect to a particular column by clicking on the corresponding
header.

The sections “Global Definitions” on page 65 and “Parameters, Functions,
Variables, and Couplings” on page 110 show you more about working with
parameters.
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So far, you have added the physics and study,
imported a geometry, added the material,
and defined one parameter. The Model

Model Builder v R

- R

Builder node sequence should now match ‘ i’%‘g’f"m hfreot
: = = =) Global Definitions
the figure to the right. The default feature Pi Parameters
nodes under Solid Mechanics are indicated by B Materials
: 3 5 5 ' W Component1 {compl)

a D in the upper-left corner of the node icon = Definitions
D 4 A\ Geometry1
0 [ Import 1 (imp2)
The default nodes for Solid Mechanics arc: Form Union o)

. . o _— 4 325 Materials
Linear Elastic Material, Free, and Initial Values. S8 Structural steel (matd)

4 527 Solid Mechanics (solid)

The node Linear Elastic Material is the default om : :
ww Linear Elastic Material 1

material model for the Solid Mechanics o Free1
interface. The node Free is a boundary A'hﬁ:“;"" Values1
condition that allows all boundaries to move 4~ Study 1

freely without a constraint or load. The node & Esiffs" X Stationary

Initial Values is used for specifying initial
displacement and velocity values for a
nonlinear or transient analysis (not applicable in this case).

The default physics nodes cannot be removed. Instead, you specify physics settings
that deviate from that of the default nodes by adding additional nodes. These
additional nodes can override or contribute to the settings of the default nodes as
well as other nodes. For more information, see “Override and Contribution:
Exclusive and Contributing Nodes” on page 126.

At any time, you can save your model and then open it later in exactly the state in

which it was saved.

3 From the File Menu, sclect File > Save As. Browse to a folder where you have
write permissions, and save the file as wrench.mph.

| 41

107



Physics and Boundary Conditions

With the geometry and materials defined, you are now ready to set the boundary
conditions.

| In the Model Builder,

4 33z Materials

right-click Solid Mechanics b sis Structural steel (mat1)
(solid) = and select Fixed @ - = sotsmechanics o)
Constraint s Linear Elastic Materi Initial Values
- . T Freel Cell Periodicity
. .. =S
This boundary condition & 'M= ‘E';'a‘va'”951 Material Models
. . [
constrains the displacementof | ., g1 Volume Forces
cach point on a boundary [ Step 1: Stationary Mass, Spring, and Damper
surface to be zero in all b @ Result Domain Constraints
directions. = Free
2 = Boundary Load
You can also use the ribbon ~ .
d l of f tl Physi mw Fixed Constraint
and:scicct, lrom-the ysles mw Prescribed Displacement

tab, Boundaries > Fixed Lo
Constraint.

2 In the Graphics window, rotate the
geometry by clicking anywhere in the
window and then dragging the wrench
into the position shown. Click on the
exposed front surface of the partially
modeled bolt. The boundary turns blue
indicating that it has been selected. The
Boundary number in the Selection list
should be 35.

3 Click the Go to Default View button .;. on the Graphics toolbar to restore the
geometry to the default view.

Graphics @_
Qa@- @@ B

Go to Default View
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4 In the Model Builder, right-click Solid Mechanics (solid) = and sclect Boundary
Load. A Boundary Load node = is added to the Model Builder scquence.

4 £33 Solid Mechanics (solid)
i Linear Elastic Material 1
T Freel
i Initial Values 1
mw Fixed Constraint1
»y Boundary Load 1
A Mesh1

The “warning” attribute displayed on the Boundary Load node indicates that
its boundary selection is empty. The next step will be to select a boundary.

5 In the Graphics window, click the Zoom =
Box button ;@ on the toolbar and drag
the mouse to select the square region
shown in the figure to the right.
Release the mouse button to zoom in
on the selected region.

6 Sclect the top socket face (boundary
111) by clicking the boundary to
highlight it in blue and add it to the
Selection list.

7 In the Settings window for Boundary

¥ Force
Load, under Force, sclect Total force as Long
the Load type and enter -F in the text it
l Total force v

field for the z component. The negative = :
sign indicates the negative z direction Fror 0 ; N
(downward). With these settings, the -F z
load of 150 N will be distributed

uniformly across the selected surface.
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Note that to simplify the modeling process, the mechanical contact between the
boltand the wrench is approximated with a material interface boundary condition.
Such an internal boundary condition is automatically defined and guarantees
continuity in normal stress and displacement across a material interface. A more
detailed analysis including mechanical contact can be done with the Structural
Mechanics Module.

SELECTING BOUNDARIES AND OTHER GEOMETRIC ENTITIES

When a boundary is unselected, its color is typically gray. The exception is when
you use the material Appearance sctting available in Materials; sce page 76. To
select a boundary, first hover over it. This highlights the boundary in red,
assuming the boundary was previously unselected. Now, click to select the
boundary by using the left mouse button. The boundary now turns blue. Its
boundary number will appear in the Selection list in the Settings window of the
corresponding boundary condition. Once a boundary is selected and you hover
over it again, the boundary turns green. If you click a boundary highlighted in
green, the boundary is deselected and now turns gray again. The same technique
for selecting and deselecting is applicable to geometry objects, domains,
boundaries, edges, and points.

The figure below shows the different selection states for a boundary.

Highlighted for selection Selected Highlighted for deselection

To select internal surfaces that are hidden behind the one closest to you, use one
of the following methods to cycle through the boundaries at the mouse pointer:
roll the mouse scroll wheel, use the keyboard + and - buttons, use the keyboard
arrow-up and arrow-down buttons, or use two-finger drag on a touchpad.

SELECTING USING THE GRAPHICS WINDOW CONTEXT MENUS
As an alternative selection method, as of version 5.5, you can right-click in the

Graphics window and select one of the options for domain, boundary, edge, or
point selection.

44 |

110



For example, to assign a Boundary Load boundary condition, first right-click and
sclect New Boundary Selection, as shown in the figure below.

B New Domain Selection

= New Boundary Selection
B New Edge Selection
E% New Point Selection

Click to select the boundaries to which you would like to apply the boundary
condition. (In this case, the top socket face; boundary I'11.) Then, right-click
again and select Boundary Load, as shown in the figure below.

Add to Boundary Selection for Fixed Constraint 1

Select Domains
Select Boundaries
Select Edges
Select Points

Disable Mouse Selection

Show Selections for Fixed Constraint 1

Free

Boundary Load

Fixed Constraint

Prescribed Displacement

vy« 70O« +

Roller

Connections »
Mass, Spring, and Damper »
More Constraints >

Pairs 4

You can also use this method to add additional boundaries to the selections of an
already created boundary condition. In the example above, you could, for
example, select the menu option Add to Boundary Selection for Fixed Constraint |
(although it wouldn’t be applicable in this example).
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Mesh

The mesh settings determine the resolution of the finite element mesh used to
discretize the model. The finite element method divides the model into small
clements of geometrically simple shapes, in this case tetrahedra. In each
tetrahedron, a set of polynomial functions is used to approximate the structural
displacement field — how much the object deforms in each of the three
coordinate directions. The stress is then computed by differentiating the
displacement field.

In this example, because the geometry contains small edges and faces, you will
define a slightly finer mesh than the default setting suggests. This will better
resolve the variations of the stress field and give a more accurate result. Refining
the mesh size to improve computational accuracy always involves some sacrifice in
speed and typically requires increased memory usage.

| In the Model Builder, under Component I, click Mesh 1 4 . In the Settings window
for Mesh, under Mesh Settings, sclect Finer from the Element size list.

v

w

ettin

(@]
7]

&8 Build All

Label: Mesh 1

¥ Mesh Settings

Sequence type:

,. Physics-controlled mesh v |

¥ Physics-Controlled Mesh

Element size:

0 Finer ¥

Extremely fine
Extra fine
Finer

Fine
Normal
Coarse
Coarser
Extra coarse

Extremely coarse

2 Click the Build All button m in the Settings window or on the Mesh toolbar.

The resulting mesh will require about 5GB to solve. If you have a computer
with less than 5GB of RAM you can select Fine from the Element size list (instead
of Finer.)
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3 After a few seconds, the mesh is displayed in the Graphics window. Rotate the
wrench to take a look at the element size distribution (this may vary a bit
depending on the version you are running).

AVeV v
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Study

In the beginning of setting up the model, you selected a Stationary study, which
implies that a stationary solver will be used. For this to be applicable, the
assumption is that the load, deformation, and stress do not vary in time. To start
the solver:

I Right-click Study 1 - and select 4 ~® Study1
Compute = (or press F8). G [~ Step] = Compute 8
b [Te Solve| :
After a few seconds of 4 Q@ Resuls | | SpeateSolution ®

| E Data! f:2 Parametric Sweep

computation time, the default plot
is displayed in the Graphics
window. During computation, a
Progress window shows progress information from the solvers. After the
computation you can find other useful information about the computation in the
Messages and Log windows; Click the Messages and Log tabs under the Graphics

% Deri c
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window to see the kind of information available to you. The Messages window can
also be opened from the Windows drop-down list in the Home tab of the ribbon.

Messages Progress Log
aYE
<---- Stationary Solver 1 in Study 1/Scluticn 1 (scll)

Started at Oct 7, 2019 10:55:00 AM.

Linear solver

Number of degrees of freedom sclved for: 412767.

Symmetric matrices found.

Scales for dependent variables:

Displacement field (compl.u): 1

Orthonormal null-space function used.

Iter SolEst Damping Stepsize #Res #Jac #Scl LinIt LinErr LinRes
1k 0.88 1.0000000 0.88 1 ok 3 12 7.5e-06 0.0031

Selution time: 12 s.

Physical memory: 1.82 GB

Virtual memory: 2.24 GB

Ended at Oct 7, 2019 10:55:12 AM.

————— Stationary Solver 1 in Study 1/Sclutiocn 1 (s0ll) >

Results

The von Mises stress is displayed in the Graphics window in a default Surface plot
with the displacement visualized using a Deformation subnode. Change the
default unit (N /m?) to the more suitable MPa as shown in the following steps.

| In the Model Builder, cxpand the Results > Stress
4 (@ Results

(solid) m node, then click Surface 1 ™. b % Datasets
=12 Derived Values
R Tables
4 Stress (solid)

G I ™ Surface 1
b £ Applied Loads (solid)

Export

2 In the Settings window under

Expression, from the Unit list, sclect TREstEson w &
MPa (or type MPa in the field). Expression:

solid.mises

Unit:

MPa v

[] Description:

von Mises stress
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3 Click the Plot button = on the toolbar of the Settings window for the Surface
plot and then click the Go to Default 3D View button .. on the Graphics window
toolbar.

The von Mises stress distribution is shown in the bolt and wrench under an
applied vertical load.

Surtace: von Mess stress (MPa) o

130

x10t

For a typical steel used for tools like a wrench, the yield stress is about 600 MPa,
which means that we are getting close to plastic deformation for our 150 N load
(which corresponds to about 34 pounds force). You may also be interested in a
safety margin of, say, a factor of three. To quickly assess which parts of the wrench
are at risk of plastic deformation, you can plot an inequality expression such as
solid.mises>200[MPa].

| 49

115



I Right-click the Results node = and add a 3D Plot Group @ .

4 Results
@ Data Wl 3D Plot Group 0

Deriv . 2D Plot Group

Bl Table ~, 1p piot Group
4 Stres
, ™ g ) Polar Plot Group

Appl @7 Smith Plot Group

Evaluation Group

Parameters

&

Pi

Plot Al
=

Show More Options...

Node Group

Copy as Code to Clipboard 4

-]

Help F1

2 Right-click the 3D Plot Group 3node @ and select Surface ™.

4 (@ Results

Datasets
222 Derived Values
B Tables

4 | Stress (solid)

b ™ Surface 1

Plot In
‘ Volume

< Arrow Volume

™ Surface @

3 In the Settings window for Surface,
click the Replace Expression button %
and sclect Model > Component! > Solid Expression:
Mechanics > Stress > solid.mises-von ol misee ARNE Sl
Mises stress - Nim? by double-clicking. Unit
When you know the variable name
beforehand, you can also directly enter
solid.mises in the Expression ficld.
Now edit this expression to:
solid.mises>200[MPa].

This is a boolean expression that evaluates to either 1 for true or 0 for false. In
areas where the expression evaluates to 1, the safety margin is exceeded.

4 Click the Plot button = .

~ Expression =Epv %~

[[] Description:

solid.mises>200[MPa]
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5 In the Model Builder, click 3D Plot Group 2. Press F2 and, in the Rename 3D Plot
Group dialog box, enter Safety Margin. Click OK. Alternatively, edit the label
at the top of the Settings window.

The resulting plot shows that the stress in the bolt is high, but the focus of this
exercise is on the wrench. If you wish to comfortably certify the wrench for a
150 N load with a factor-of-three safety margin, you would need to change the
handle design somewhat, such as by making it wider.

Surfacel solid miser>200|MPa]

You may have noticed that the manufacturer, for various reasons, has chosen an
asymmetric design for the wrench. Because of that, the stress field may be different
if the wrench is flipped around. Try now, on your own, to apply the same force in
the other direction and visualize the maximum von Mises stress to see if there is
any difference.

Convergence Analysis

The results from a simulation software such as COMSOL Multiphysics can
shorten design times dramatically by, for example, reducing the number of
experiments or product tests. However, simulation software is not a substitute for
real-world testing. This is especially important if there are risks for physical or
environmental damage. One way to reduce (but not eliminate) the risk of drawing
the wrong conclusions from simulation results is to perform a convergence
analysis.
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To check the accuracy of the computed maximum von Mises stress in the wrench,
you can now continue with a mesh convergence analysis. Do that by using a finer
mesh and therefore a higher number of degrees of freedom (DOFs).

This section illustrates some more in-depth functionality and the steps
below could be skipped at a first reading. In order to run the convergence
analysis below, a computer with at least 4GB of memory (RAM) is
recommended.

EVALUATING THE MAXIMUM VON MISES STRESS

I To study the maximum von Mises stress in the wrench, in the Results section of
the model tree, right-click the Derived Values :: node and sclect Maximum >
Volume Maximum ...

2 In the Settings window for Volume Maximum, under Selection, choose Manual and

select the wrench, domain 1, by clicking on the wrench in the Graphics window.
We will only consider values in the wrench domain and neglect those in the bolt.

3 In the first row of the Expressions table, in the Expression column, type
solid.mises. To find the expression for the von Mises stress, you can also click
the Replace Expression button % and browse to this variable.

4 In the Expressions table, type MPa as the Unit.

Settings

Volume Maximum

= Evaluate v

Label: Volume Maximum 1 =]

v Data

Dataset: | Study 1/Solution 1 (sol1) IE]
Selection

Selection: \ Manual v

Active ﬁﬁ \Q‘I

..

~ Expressions + - %~

» X s i
Expression Unit Description

solid.mises MPa von Mises stress 6
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5 In the Settings window for Yolume Maximum,

. . Messages Progress Lo Table 1
click Evaluate to evaluate the maximum stress. 2 4 g

. } X ] | N N o N[ E

The result will be displayed in a Table =l nEE

window and will be approximately 375 MPa. von Mises stress (MPa) e
375.50

6 To see where the maximum value is attained,
you can usc¢ a Max/Min Volume plot.
Right-click the Results node = and add a 3D Plot Group @ . Next, right-click the
3D Plot Group 4 node @ and sclect More Plots > Max/Min Volume .

7 To plot values in the wrench and not in the bolt, right-click the Max/Min Yolume
= node and select Selection and select the wrench domain number 1.

8 In the Settings window for Max/Min Volume, in the Expression text field, type
solid.mises.

9 In the Settings window under Expression, from the Unit list, select MPa (or enter
MPa in the field).

10 Click the Plot button = . This type of plot simultancously shows the location of
the maximum and minimum values and also their coordinate location in the
table below (the exact values may differ depending on the version you are
running).

sraph Convergence Plot 1 A

QaA-@ Lvrxklznm ¢ MEDEMC-a=

Max/Min Volume: von Mises stress (MPa) o

v‘_L. x
Messages Progress Log  Maxmum and minimum values 1
L B R Lolch
X Y z von Mises stress (MPa)

0062743 00070844 |- 246564 043067
0055736 00031750 |-00050152 47230
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PARAMETERIZING THE MESH

We will now define a parametric sweep for successively refining the mesh size while
solving and then finally plot the maximum von Mises stress vs. mesh size. First, we
define the parameters that will be used for controlling the mesh density.

1
2

6 In the Settings window for Size, under

In the Model Builder, click Parameters 1 » under Global Definitions ).

Go to the Settings window for Parameters. In the Parameters table (or under the
table in the fields), enter these settings:

- In the Name column or field, enter hd. This parameter will be used in the
parametric sweep to control the element size.

- In the Expression column or field, enter 1.
- In the Description column or field, enter Element size divider.

Now, enter another parameter with

s Settin

Name hO, Expression 0.01, and S€ttings 9

Description Starting element size. Paramelers

This parameter will be used to define ~ Parameters

the element size at the start of the > - o

3 Name Expression Value Description

paramectric sweep. F 150[N] 150N | Applied force

In the Model Builder, under Component hd d 1 Element stze'divider
h0 0.01 10.01 Starting element size

I, click Mesh | 4 . In the Settings
window for Mesh, sclect User-controlled
mesh from the Sequence type list.

Under Mesh 1, click the Size node 4.

. ¥ Element Size Parameters
Element Size, click the Custom button.

Maximum element size:

Under Element Size Parameters, cnter: ho/hd m

- h0/hd in the Maximum element size ficld. @ Minimum element size:
: 2 g : ho/(4*hd)
- h0/(4*hd) in the Minimum element size "

Maximum element growth rate:

field. =
- 1.8 in the Maximum element growth rate Curvature factor:
field. 01
. - - Resolution of jons:
- 0.1 in the Curvature factor field. Oe:” i b

- 0.2in the Resolution of narrow regions
field.

See page 85 for more information on the element size parameters.

PARAMETRIC SWEEP AND SOLVER SETTINGS

As a next step, add a parametric sweep for the parameter hd.

54 |

120



| In the Model Builder, right-click Study 1 - and
sclect Parametric Sweep :::. A Parametric Sweep 0
node is added to the Model Builder scquence.

4 ~db Study 1
£ Parametric Sweep

Step 1: Stationary
. . 4 [rs. Solver Configurations
2 In the Settings window for Parametric Sweep,

under the table in the Study Settings section, click the Add button +. From the
Parameter name list in the table, select hd.

3 Enter a range of Parameter values to

5 < Settings

sweep for. Click the Range || button ;“tt tg’_
: arametric Sweep

and enter the values in the Range = Compute

dialog box. In the Start ficld, enter 1. |, poameic sweep =]
In the Step ficld, enter 1, and in the -
Stop ficld, enter 6. Click Replace. The
Parameter value list will now display
range(1,1,6).

¥ Study Settings
Sweep types | Specified combinations ~|

"
Parameter name Parameter valus list  Parameter unit

| hd (Eiement size dvider) ~ | range(1,1,5)
The settings above make sure that as e
the sweep progresses, the value of the

parameter hd increases and the

maximum and minimum element sizes decrease.

See page 141 for more information on defining parametric sweeps.

For the highest value of hd, the number of DOFs will exceed one million.
Therefore, we will switch to a more memory-efficient iterative solver.

4 Under Study | > Solver Configurations > Solution I, cxpand the Stationary Solver
I node |z, and right-click Suggested Iterative Solver~] and sclect Enable.
Selecting an iterative solver option typically reduces memory usage but can
require physics-specific tailoring of the solver settings for efficient
computations.

5 Under General in the Settings window for Suggested Iterative Solver, change the
Preconditioning to Right. (This is a low-level solver option, which in this case will
suppress a warning message that would otherwise appear. However, this setting
does not affect the resulting solution. Preconditioning is a mathematical
transformation used to prepare the finite element equation system for using the
iterative solver.)

6 Click the Study I node and select Compute =, cither in the Settings window or
by right-clicking the node. You can also click Compute in the ribbon Home or
Study tab. The computation time will be a few minutes (depending on the
computer hardware) and memory usage will be about 4GB.

RESULTS ANALYSIS

As a final step, analyze the results from the parametric sweep by displaying the
maximum von Mises stress in a table.
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| In the Model Builder under Results > Derived Values, sclect the Volume Maximum
I node .

The solutions from the parametric sweep are stored in a new Dataset named
Study I/Parametric Solutions 1. Now, change the Volume Maximum scttings
accordingly:

2 In the Settings window for Yolume Maximum, change the Dataset to Study
I/Parametric Solutions |.

3 Click the arrow next to the Evaluate button at the top of the Settings window
for Yolume Maximum and select to evaluate in a New Table. This evaluation may
take 20 seconds or so.

4 To plot the results in the Table, click the Table Graph = button at the top of the
Table window (the first few values will vary depending on the version due to
slight mesh variations for coarser meshes before a converged value has been
reached).

8.85 85 B850 @ @ Grapt
- T . s 0ss5
e griey A aqaRa+*B U=Oc @

hd  von Mises stress (MPa)

1.0000[3.8312E5
2,0000/5032.5
3.00002809.8
4.000013290.5
5.0000/880.12
6.0000/901.32

von Mzes strez (MFa)

36+ |

34

sk |
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24

22+
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06
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It is more interesting to plot the maximum value vs. the number of DOFs. This
is possible by using the built-in variable numberofdofs.

5 Right-click the Derived Values node :: and select Global Evaluation ).

6 In the Settings window for Global Evaluation, change the Dataset to Study

I/Parametric Solutions |.

7 In the Expressions ficld, enter numberofdofs.

You can type the first few characters of the variable name and then use
the keyboard shortcut Ctrl+Space to get a variable suggestion from the

list of available variables.
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8 In the Settings window for Global Evaluation, click the arrow next to the Evaluate
button and select the option to evaluate in Table 2. This displays the DOF values
for each parameter next to the previously evaluated data.

This convergence analysis shows that the computed value of the maximum von
Mises stress in the wrench handle will decrease from the high original value, for a
mesh with about 40,000 DOFs, to 375 MPa for a mesh with about 1,000,000
DOFs. It also shows that above 500,000 DOFs the results have essentially the
same accuracy as for 1,000,000 DOFs.

The figure below shows the associated Table Graph and Table Graph Settings
window.

aaa-H UEDC- @@ v i
>
26
34 \ —
32 Label: Table Graph 1 E
3
: v Data
§ 24 [ (e — 1
2 22 Source: | Table v |
§ o Table: Table 2 E
£ 16 \ = =
5o x-axis data: | Automatic v
1.2 —
1 Plot columns: Manual v
08 \
06 \ Columns:
0s
i \ hd
o = — : n —— von Mises stress (MPa)
1 1s 2 25 3 3 4 45 5 55 6

Number of degrees of freedom (1)

Note that depending on the version of COMSOL Multiphysics that you are
running, the above values may vary slightly due to variations in the number of
elements generated by the meshing algorithm.

As an alternative to Derived Values, you can use Evaluation Groups. An Evaluation
Group shares some of the properties of Plot Groups as well as Derived Values. An
Evaluation Group comes with an integrated table whereas Derived Values outputs to
a table of your choice. In addition, Evaluation Groups allows you to automatically
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re-evaluate after solving. To enable this, select the corresponding check box in the
Settings window of the Results node as shown in the figure below.

ettmg v

vy

¥ Update of Results

["] Only plot when requested
Recompute all plot data after solving
Reevaluate all evaluation groups after solving

¥ Save Data in the Model

Save plot data: \7Autogat|c v/

In this Settings window you can also request to regenerate all plots after solving.
You add an Evaluation Group in the same way as a Plot Group by right-clicking the
Results node. The figure below shows an Evaluation Group that performs the same
task as the Derived Values described earlier.

4 (G Evaluation Group 1
max Volume Maximum 1
Global Evaluation 1

The figure below shows the corresponding Evaluation Group table.

Messages Progress Log Evaluation Group 1

B w2 B VI aEZ3EE -~
hd von Mises stress (N/m*2) Number of degrees of freedom (1)

1.0000 |1532430374 4217

2.0000 405348707 114864

3.0000 389445143 1250548

4.0000 383066839 447384

5.0000 (377347488 702099

6.0000 (375450208 951522

This concludes the wrench tutorial.
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